BRIDGING THE GAP: VISUAL TOOLS FOR 3-TELESA MRI
INTERPRETATION OF THE DELTOID LIGAMENT

by
Michael Silver

A thesis submitted to the Johns Hopkins University in conformity with the requirements
for the degree of Masters of Arts

Baltimore, Maryland
March, 2014

© 2014 Michael Silver
All Rights Reserved
ABSTRACT

The ankle is one of the most commonly injured joints of the human body requiring detailed anatomical knowledge and proper diagnostic abilities in a clinical setting. As key stabilizers of the talocrural joint, the ankle ligaments are the main sites of these injuries. The deltoid ligament complex (Medial Collateral Ligament Complex) is a multi-component complex with a deep layer and a superficial layer. Due to its complexity, much confusion surrounds the definitions and diagnoses of these components in medical literature. High-Field 3-Tesla MR imaging is an extremely effective method for ligament injury evaluation and is considered harmless to patients; however, its diagnostic effectiveness is completely dependent on the radiologist’s interpretation abilities. Current radiological training tools have several weaknesses, posing a significant challenge to providing proper image interpretation training. In this study, multiple deltoid ligament dissections were conducted to gain a detailed structural understanding. Photogrammetry models were created from the dissected specimens. A digital 3D model was produced utilizing CT, MR, and photographic data. This model was then utilized in an animation to demonstrate the anatomy, MR appearance, and injury characteristics of the deltoid ligament complex. A 3D printed model was also produced as an additional visual aid. Several useful workflows were developed for future medical visualization projects. The anticipated clinical benefit of this project is the improvement in the diagnostic abilities of radiologic and orthopedic residents in regards to the deltoid ligament complex through these novel 3D visualizations.

Author

Michael Silver, MA Candidate
Department of Art as Applied to Medicine
Johns Hopkins University School of Medicine
Faculty Advisor

David Rini, MFA, CMI
Associate Professor
Art as Applied to Medicine
Cellular and Molecular Medicine
Johns Hopkins School of Medicine

Preceptor

John A. Carrino, M.D., M.P.H.
Associate Professor of Radiology
Associate Professor of Orthopaedic Surgery (cross-appointment)
Associate Professor of Biomechanical Engineering (cross-appointment)
Section Chief, Musculoskeletal Radiology
Russell H. Morgan Department of Radiology and Radiological Science
Johns Hopkins Hospital
ACKNOWLEDGEMENTS

This project would not have been remotely possible without the guidance, expertise, and support of many people. It has been an absolute pleasure to work with so many incredible individuals. I would sincerely like to thank the following people:

Dr. John A. Carrino, my preceptor and Associate Professor of Radiology, Orthopaedic Surgery, and Biomechanical Engineering, Section Chief of Musculoskeletal Radiology in the Russell H. Morgan Department of Radiology and Radiological Science at Johns Hopkins Hospital, for the generous contributions of his time, invaluable expertise, and imaging resources. His encouragement, insight, and humor made this project both incredibly educational and fun.

Dr. Kenneth C. Wang, my co-preceptor and Staff Radiologist, at the Baltimore VA Medical Center and Assistant Professor at Johns Hopkins University School of Medicine, for his time and energy, enlightening image review sessions, and for sharing his wealth of radiological, anatomical, and technological knowledge.

David Rini, my advisor and Associate Professor in the Art as Applied to Medicine and Cellular and Molecular Medicine Departments at Johns Hopkins School of Medicine, for his creative input, thorough and honest feedback, confidence in my abilities, and guidance. His is an example I hope to follow as a medical illustrator and human being.

Solomon Abay, Medical Student at Johns Hopkins School of Medicine, for his numerous image review sessions, his thorough edits, and invaluable assistance during dissection and the photogrammetry capture process.

Dr. Gaurav Thawait, Post Doctoral Research Fellow in the Musculoskeletal Radiology Section in Russell H. Morgan Dept. of Radiology and Radiological Science at Johns Hopkins University School of Medicine, for his continual assistance with arranging scans, transferring scan data, and reviewing images.

Miguel Schoen and Dr. Benjamin Stein, for their guidance and wisdom during dissection

Valerie DeLeon, Ellen Powell, Nicole Squyres of the Functional Anatomy and Evolution Department for their assistance in obtaining bone specimens.
Sarah Poynton, for her invaluable and ever-cheerful assistance during grant application and presentation preparation.

Michael Raphael, Jeff Mechlinski, Peter Kennedy, and Jon Wood for generously donating their time, scans, and technical expertise.

The Vesalius Trust, for their generous grant to support this project

Gary Lees, and Corinne Sandone, for leading such an incredible department and being unwavering advocates for their students.

Juan Garcia, for his helpful photogrammetry discussions and input

Dacia Balch, for her superhuman ability to remain calm in the midst of daily storms, selflessly putting others before herself, all with a smile.

Carol Pfeffer, for her enthusiastic support and positivity.

The entire faculty of the Department of Art as Applied to Medicine, for their countless hours of artistic and professional guidance and encouragement.

My parents, Dan and Lynnette Silver, for their truly unconditional and everlasting love, patience, and support throughout my life. I will never be able to express in words how truly grateful I am for everything.

Stephen, Sophia, and Lily, for their continual love and encouragement.

My closest friends Lee, Erin, Dave, Ryan, Chris, Jeff, Andy, Dan, Nicole, JR, Laura, and Oren, for their truly unconditional love and support, and for reminded me of who I truly am during times of otherwise impossible challenge.

My classmates Chris, Sam, James, Jackie, Veronica, and Katelyn and the Classes of ’13 and ’15, for putting up with my antics and pushing me to perform at my best through both encouragement and challenge.

Man-San Ma, for her constant support and confidence in me.

Rey Bustos, Eric Sloate, and Stan Winston, for their Anatomical, Biological, and Artistic passions and mentoring that inspire me to this day.

Rick, John, Tony, and Greg at the entire crew at Royer Labs, for trusting in my talents and ingenuity, and giving me the freedom to explore the world of prototyping

Richard Burr, Reza Nabavi, and Anthony Robbins

for their spiritual and emotional guidance through the roughest of waters.
# TABLE OF CONTENTS

Abstract ........................................................................................................................................ ii

Acknowledgements .................................................................................................................. iv

Table of Contents .................................................................................................................. vi

List of Figures ....................................................................................................................... viii

**Introduction** .......................................................................................................................... 1

- Background ............................................................................................................................... 1
- Challenges ................................................................................................................................. 7
- My Approach .......................................................................................................................... 8

**Materials and Methods** ........................................................................................................ 10

- Project Approach ..................................................................................................................... 10
  - Meetings and Communications ............................................................................................ 10
  - Software and Equipment ....................................................................................................... 11
- Part 1: Dissection .................................................................................................................... 12
  - Photographic Documentation .............................................................................................. 13
- Part 2: Dissection Photogrammetry Models ........................................................................... 19
  - Photogrammetry Capture ..................................................................................................... 19
  - Photogrammetry Digital Model Creation ........................................................................... 21
  - Model Modification and QTVR Exporting ......................................................................... 22
- Part 3: Model and Animation .................................................................................................. 24
  - Narration ............................................................................................................................... 24
  - Storyboard ............................................................................................................................ 25
  - Surface Render and QTVR Export from OsiriX ................................................................. 28
  - Creation of Model in ZBrush ............................................................................................... 35
  - Animation in Cinema 4D ...................................................................................................... 76
  - Compositing in After Effects ............................................................................................... 101
  - 3D Printed Model ................................................................................................................ 101
<table>
<thead>
<tr>
<th>Results</th>
<th>102</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dissection</td>
<td>102</td>
</tr>
<tr>
<td>123D Catch Digital Dissection Models (QTVRs)</td>
<td>103</td>
</tr>
<tr>
<td>Digital Model</td>
<td>106</td>
</tr>
<tr>
<td>Animation</td>
<td>106</td>
</tr>
<tr>
<td>3D Print of ligaments</td>
<td>106</td>
</tr>
<tr>
<td>Access to Assets Resulting from This Thesis</td>
<td>117</td>
</tr>
<tr>
<td><strong>Discussion</strong></td>
<td>118</td>
</tr>
<tr>
<td>Exploratory Approach</td>
<td>118</td>
</tr>
<tr>
<td>Innovations and Applications</td>
<td>119</td>
</tr>
<tr>
<td>Obstacles and Solutions</td>
<td>122</td>
</tr>
<tr>
<td><strong>Conclusion</strong></td>
<td>125</td>
</tr>
<tr>
<td><strong>Cited References</strong></td>
<td>126</td>
</tr>
<tr>
<td><strong>General References</strong></td>
<td>128</td>
</tr>
<tr>
<td><strong>Vita</strong></td>
<td>130</td>
</tr>
</tbody>
</table>
INDEX OF FIGURES

Figure 1. Preserved dissection demonstrating deep (left probe) and superficial (right probe) layers.................14
Figure 2. Preserved dissection demonstrating TCL (green), TSL (red), and TNL (white) components.................14
Figure 3. Preserved dissection demonstrating tibia and fibula reflected medially........................................15
Figure 4. Preserved dissection demonstrating PTTL attachment site..........................................................15
Figure 5. Unpreserved dissection demonstrating flexor retinaculum..........................................................16
Figure 6. Flexor retinaculum incision in unpreserved dissection..................................................................16
Figure 7. Retraction of tibialis posterior tendon in unpreserved dissection....................................................17
Figure 8. Unpreserved dissection after tendon removal..................................................................................17
Figure 9. Unpreserved dissection demonstrating TNL (probe), TSL (probe), and TCL (hemostat)......................18
Figure 10. TNL identified in unpreserved dissection.....................................................................................18
Figure 11. Photogrammetry photo shoot setup..............................................................................................20
Figure 12. Autodesk 123D Catch launch button..........................................................................................20
Figure 13. Photogrammetry model OBJ exporting link..................................................................................23
Figure 14. Texture map image applied to material color and luminance channels in Cinema 4D......................23
Figure 15. Three-dimensional surface laser scan of tibia..............................................................................26
Figure 16. Polyworks software constructing point cloud model.....................................................................26
Figure 17. MR scan of unpreserved specimen..............................................................................................27
Figure 18. Trimming CT volume render with the scissors tool in OsiriX........................................................29
Figure 19. Selecting the 3D Surface Rendering option.....................................................................................29
Figure 20. Adjusting the surface render settings............................................................................................30
Figure 21. Selecting the Export QTVR option..................................................................................................30
Figure 22. Adjusting QTVR render settings.....................................................................................................32
Figure 23. Adjusting QTVR compression settings..........................................................................................32
Figure 24. Distal QTVR exported from OsiriX...............................................................................................33
Figure 25. Proximal QTVR exported from OsiriX........................................................................................33
Figure 26. Selecting the Remove Isolated pieces (wrt Diameter) function in MeshLab......................................34
Figure 27. Adjusting the Remove Isolated Pieces (wrt Diameter) settings......................................................34
Figure 28. Preprocessing for decimation........................................................................................................36
Figure 29. Decimating at 50%......................................................................................................................36
Figure 30. Hiding unwanted geometry with the selection lasso in ZBrush......................................................37
Figure 31. Geometry prior to Close Holes operation.......................................................................................37
Figure 65. Trim Lasso selection tool ..............................................................54
Figure 66. Trimming PTTL mesh with TrimLasso selection tool ......................54
Figure 67. Trimmed PTTL mesh .................................................................55
Figure 68. Dynameshed and smoothed PTTL mesh ......................................55
Figure 69. ATTL mesh created from ZSpheres ...........................................56
Figure 70. Trimming ATTL mesh with TrimLasso selection tool ...................56
Figure 71. ATTL mesh after trimming ..........................................................57
Figure 72. Desired bone area geometry after selection with the Lasso selection tool .................................57
Figure 73. Projection of ATTL mesh onto bone surface from inside using ZProject brush ..........................58
Figure 74. Projection of PTTL mesh onto bone surface from inside using ZProject brush .........................58
Figure 75. TCL mesh after shaping with the Smooth and Move Topological tool .........................................60
Figure 76. TCL mesh after flattening with the Flatten brush ...........................60
Figure 77. TSL mesh after ZRemeshing operation ........................................61
Figure 78. Completed ligament meshes as separate subtools ..........................61
Figure 79. Merged ligament meshes in separate polygroups within one subtool ........................................62
Figure 80. ZSpheres sized and positioned to create synovial capsule ..............63
Figure 81. Mesh created from ZSpheres ......................................................63
Figure 82. Remeshing with bones set to subtract from synovial capsule mesh ........................................64
Figure 83. Synovial capsule mesh created from subtraction remesh operation ..........................64
Figure 84. Shaping synovial capsule with TrimLasso, Dynamesh, and brushes ........................................65
Figure 85. Shaping synovial capsule with TrimLasso, Dynamesh, and brushes ........................................65
Figure 86. Capsule mesh after sculpting with Move Topological and Smooth brushes ...................................66
Figure 87. Capsule mesh ghosted to view relationship to talocrural joint ..........66
Figure 88. UV map creation with UV Master plugin ....................................68
Figure 89. Texture map created from UV map ...........................................68
Figure 90. Exporting low resolution model with UV texture map ....................69
Figure 91. Checking UV Texture Map application in Cinema 4D compared to ZBrush ..................................69
Figure 92. Mask painted to create PTTL attachment texture map ..................70
Figure 93. PTTL attachment texture map created from mask ........................70
Figure 94. Exporting PTTL attachment texture map ......................................71
Figure 95. PTTL attachment texture map tested as luminance mask in Cinema 4D .....................................71
Figure 96. CT based mesh (left) and laser scan data mesh (right) ......................73
Figure 97. Laser scan data mesh (left) CT based mesh (right) .........................73
Figure 98. Aligning laser scan data mesh with CT based mesh using Transpose tool.................................74
Figure 99. Incomplete CT mesh deep within laser scan mesh in posterior calcaneus area............................74
Figure 100. Using ZProject brush to repair incomplete area of CT based mesh using laser scan mesh............75
Figure 101. Repaired posterior calcaneus region of CT based mesh..........................................................75
Figure 102. Importing merged bones OBJ file exported from ZBrush.......................................................79
Figure 103. Importing merged ligaments OBJ file exported from ZBrush..................................................79
Figure 104. Imported ligament meshes renamed.......................................................................................80
Figure 105. Photoshop action created to invert and vertically flip luminance mask texture map....................82
Figure 106. Luminance mask layering setup...............................................................................................82
Figure 107. Keyframing of glow effect.......................................................................................................84
Figure 108. Keyframing of transparency effect...........................................................................................84
Figure 109. View from inside section booles..............................................................................................86
Figure 110. Section booles enabled...........................................................................................................86
Figure 111. Copying animated cancellous bone texture from test project....................................................87
Figure 112. Applying animated cancellous bone texture to bone mesh.....................................................87
Figure 113. Adjusting cancellous bone material..........................................................................................88
Figure 114. Test rendering animated section effect...................................................................................88
Figure 115. Slice orientation and contrast set in multi-plane viewer of OsiriX..............................................90
Figure 116. Annotations hidden to prevent visibility in movie export......................................................90
Figure 117. Slice range and Quicktime movie settings...............................................................................91
Figure 118. Xpresso setup for MR image slices..........................................................................................91
Figure 119. Locating correct model section location for MR image.............................................................93
Figure 120. Locating first identifiable MR image and correlated model section location............................93
Figure 121. Aligning MR plane with bone mesh using MR alignment null.................................................94
Figure 122. Fine tuning alignment of MR plane with bone mesh using MR alignment null............................94
Figure 123. Checking operation of constant node z-position to frame ratio set Xpresso.................................95
Figure 124. Using MR alignment null to position MR plane by matching MR image to bone mesh..............95
Figure 125. Using MR alignment null to position MR plane by matching MR image to bone mesh..............96
Figure 126. Using MR alignment null to position MR plane by matching MR image to bone mesh..............96
Figure 127. Checking MR alignment from posterior view............................................................................97
Figure 128. Section booles prior to alignment with MR plane.....................................................................97
Figure 129. Fine tuning section boole alignment with MR plane.................................................................98
Figure 130. Section booles aligned with MR plane....................................................................................98
Figure 131. Section booles disabled for faster processing ................................................................. 99
Figure 132. QTVR of preserved dissection ...................................................................................... 103
Figure 133. QTVR of preserved dissection ...................................................................................... 103
Figure 134. QTVR of preserved dissection ...................................................................................... 104
Figure 135. QTVR of preserved dissection ...................................................................................... 104
Figure 136. Low resolution render of deltoid ligament model ......................................................... 106
Figure 137. Low resolution render of deltoid ligament model ........................................................ 106
Figure 138. Low resolution render of deltoid ligament model ........................................................ 107
Figure 139. Low resolution render of deltoid ligament model ........................................................ 107
Figure 140. Animatic still highlighting tibia .................................................................................... 108
Figure 141. Animatic still highlighting deep layer of deltoid ligament ............................................ 108
Figure 142. Animatic still highlighting talocrural joint ................................................................. 109
Figure 143. Animatic still highlighting navicular bone ................................................................. 109
Figure 144. Animatic still of complete deltoid ligament ............................................................... 110
Figure 145. Animatic still of ghosted superficial layer ................................................................... 110
Figure 146. Animatic still highlighting TNL ..................................................................................... 111
Figure 147. Animatic still demonstrating TNL relationship to other components of deltoid ligament .. 111
Figure 148. Animatic still highlighting ATTL ............................................................................... 112
Figure 149. Animatic still highlighting PTTL ............................................................................... 112
Figure 150. Animatic still highlighting anterior and posterior colliculi as well as intercollicular groove. ... 113
Figure 151. Animatic still highlighting attachment sites of PTTL .................................................. 113
Figure 152. Animatic still demonstrating animated MR section effect ........................................ 114
Figure 153. Animatic still demonstrating animated MR section effect ........................................ 114
Figure 154. Animatic still demonstrating MR to model correlation ............................................... 115
Figure 155. Animatic still demonstrating MR to model correlation ............................................... 115
This Page Intended to Be Blank
INTRODUCTION

BACKGROUND

ANKLE JOINT AND LIGAMENTS

The ankle (or talocrural) joint is a region of the human body that is often taken for granted. In fact, this weight-bearing joint is a beautiful and effective example of form following function in order to balance opposing mechanical demands. The ankle must not only be articulated enough to allow the mobility needed for daily activities, it must also be durable enough to withstand extreme forces put upon it by heavy loads and intense sporting activities. One of the key components in the stabilization of the ankle is the system of ligaments that span between the leg and tarsal bones that articulate at the ankle.

Despite its robustness, the ankle is one of the most commonly injured joints during sports and recreational activities (Garrick 1977, 241-242). Many people have experienced a “sprained ankle” but few outside the medical community know exactly what that means. Many pathological conditions of the ankle exist including, fractures, ligamentous injuries, post-traumatic flat foot deformity, chronic medial instability, tarsal tunnel and medial ankle impingement syndromes, and others. Because of the central role the ligaments of the ankle play in the stabilization of the joint, pathologies of the ligament structures can lead to acute and chronic medical conditions if not diagnosed and treated appropriately.

MR IMAGING

In the years since its clinical introduction in the early 1980’s, improvements in techniques and interpretation of magnetic resonance (MR) imaging have allowed for deeper understanding of patient anatomy as well as earlier, safer, and more accurate diagnoses of pathologies. Most recently, High-Field (3-Tesla) MR imaging has been developed providing anatomical detail never before seen in clinical MR imaging due to its more powerful magnetic field. The ligaments of the ankle are of particular interest in orthopedic radiology because they are so commonly injured and exhibit pathological symptoms. MR imaging is an effective method for evaluating the complex ligaments of the ankle; however, the effectiveness of MR imaging diagnosis is completely dependent
on the radiologist's image interpretation abilities. As imaging techniques advance, radiologists are better able to visualize small ligamentous structures, and there is a need for educational resources which reflect this increasing level of imaging fidelity. This need is especially apparent in ankle ligament evaluation, a prime example of which is the deltoid ligament complex.

**Deltoid Ligament**

The anatomy of the ankle joint is extremely complex with many enmeshed, tunneling, and overlapping structures, which make it difficult to fully comprehend. Yet in order to properly diagnose pathologies, a physician must first have a solid understanding of the normal structure and function of this region. The deltoid ligament, so called due to its delta-shaped appearance, is the primary medial ligamentous stabilizer of the bones of the talocrural joint and provides a great deal of mechanical stability during ankle movement (Watanabe et al. 2012, 189-195). It acts against eversion, pronation, valgus, and rotatory forces as well as anterior and lateral talar excursion. The deltoid ligament spans from the medial malleolus of the tibia to the talus, calcaneus, navicular and spring ligament via its component ligaments. The medial malleolus is the medial projection of the distal tibia that forms the medial wall of the ankle mortise. The entire mortise articulates with the superior articular surface of the talus, the talar trochlea. On the medial malleolus are two small tubercles called colliculi. The anterior and posterior colliculi along with the intercollicular groove between them, are the specific attachment sites of the deltoid ligament.

The deltoid ligament itself is a complex consisting 5 components residing in two layers – a deep layer and a superficial layer. The deep layer consists of the anterior tibiotalar (ATTL) and posterior tibiotalar ligament (PTTL), both of which are intraarticular and lie within the synovial capsule of the talocrural joint (Mengiardi et al. 2007, 817-824). The superficial layer consists of the tibionavicular ligament (TNL), tibiospring ligament (TSL), and tibio calcaneal ligament (TCL), which lie superficial to the synovial capsule of the talocrural joint. Though not a component of the deltoid ligament, the spring ligament (or plantar calcaneonavicular ligament) spans between the anterior aspect of the sustentaculum tali of the calcaneus to the plantar surface of the navicular bone. The spring ligament supports the head of the talus in the talocalcaneonavicular joint and
plays a key role in maintaining the medial longitudinal arch of the foot (Mengiardi et al. 2007, 817-824). It is the distal attachment point for the tibiospring ligament. A significant amount of variation in both thickness and visibility/incidence exists in these ligaments.

**The Deep Ligaments**

The anterior tibiotalar ligament (ATTL) is the smallest and most buried component of the deltoid ligament complex. It attaches to the medial malleolus at the anterior colliculus and the anterior portion of the intercollicular groove and courses distally, anteriorly, and laterally to its attachment on the talus, just distal to the anterior portion of the medial talar articular surface (Pankovich and Shivaram 1979, 217-223). The ATTL is a part of the deep layer of the deltoid ligament and lies within the synovial capsule deep to the tibiospring, tibionavicular, and tibiocalcaneal ligament. Its thickness ranges from 1-4mm (Mengiardi et al. 2007, 817-824).

The posterior tibiotalar ligament (PTTL) is the thickest and most robust component of the deltoid ligament complex. It attaches to the posterior portion of the anterior colliculus, the intercollicular groove and the anterior portion of the posterior colliculus. It courses distally, posteriorly and laterally to its broad attachment on the talus, from the medial surface under the tail of the articular facet to the posteromedial talar tubercle. The PTTL is also a component of the deep layer of the deltoid ligament within the synovial capsule and lies partially underneath the tibiocalcaneal ligament of the superficial layer. Its thickness ranges from 6-11mm it contains adipose tissue interspersed between its fiber bundles (Mengiardi et al. 2007, 817-824).

**The Superficial ligaments**

The tibionavicular ligament (TNL) is the most difficult component of the deltoid ligament complex to visualize both in vivo and on imaging due to its orientation and inconsistent presence in patients. It attaches to the anterior border of the anterior colliculus and courses distally and anteriorly to the dorsomedial surface of the navicular. If present, the TNL is the most anterior component of the superficial layer of the Deltoid Ligament complex and is superficial to the synovial capsule. Its thickness ranges from 1-2mm (Mengiardi et al. 2007, 817-824).

The tibiospring ligament (TSL) is usually the thickest component of the deltoid ligament complex’s superficial layer. It attaches to the anterior aspect of the anterior colliculus of the medial malleolus. The TSL courses distally, anteriorly, and slightly laterally and broadens to its attachment
on the superomedial plantar calcaneonavicular (or spring) ligament. It is the middle component of the superficial layer of the deltoid ligament and is superficial to the synovial capsule. The TSL's thickness ranges from 1-4mm (Mengiardi et al. 2007, 817-824).

The tibiocalcaneal ligament (TCL) is a cord-like ligament and forms the posterior border of the superficial layer of the deltoid ligament. It attaches to the medial aspect of the anterior colliculus and runs distally and slightly laterally and posteriorly to its attachment on the medial aspect of the sustentaculum tali of the calcaneous. Its thickness ranges from 1-3mm (Mengiardi et al. 2007, 817-824).

**MR Diagnostic Importance and Interpretation**

High-field (3-Tesla) MR imaging can play a key role in diagnosis of pathologic conditions. Familiarity with the imaging characteristics of the anatomic substructure of the deltoid ligament allows radiologists to more accurately localize and characterize pathologic conditions and recognize associated injury patterns (Chhabra, Subhawong, and Carrino 2010, 751-761). In addition, deep deltoid injury can often go unnoticed by other imaging and clinical diagnostic methods. Untreated deltoid ligament insufficiency can lead to osteoarthritis of the ankle joint and medial ankle impingement syndromes (Chhabra, Subhawong, and Carrino 2010, 751-761). MR diagnosis can prevent these conditions and other forms of chronic ankle pain and instability by allowing early detection and prompt surgery or other treatment.

When using MR imaging to evaluate the deltoid ligament, it is critical that the radiologist be able to identify and distinguish between the different layers and components of the deltoid ligament in order to correctly interpret MR images and make proper diagnoses. Using High-Field (3-Tesla) MR units, these components become clearly identifiable allowing natural variations among patients to be seen and injuries to be diagnosed with a high degree of accuracy. The coronal, axial, and transverse oblique views are most helpful in imaging the components of deltoid ligament (Nazarenko, Beltran, and Bencardino 2013, 455-478). The foot is normally placed in neutral position or slight plantar flexion to reduce the magic angle effect (Nazarenko, Beltran, and Bencardino 2013, 455-478). Other techniques recommend dorsiflexion or plantar flexion depending on the target ligament component. Intermediate-weighted (or proton density) and T2-weighted imaging with and without fat-saturation are used depending on the ligament or pathology.
being investigated. As demonstrated by the images used in the animations, In the Musculoskeletal Section of the Johns Hopkins Radiology Department, the imaging protocol typically includes 2D and 3D-SPACE (Sampling Perfection with Application optimized Contrast using different flip angle Evolutions sequences, with and without fat suppression, with the foot in neutral position. With the advent of 3D/isotropic MR imaging, reformatted planes can be created along the length of each ligament. Each ligament also displays certain imaging characteristics that, along with their anatomical surroundings, dimensions, and attachment sites, can be used to verify their presence and interpret their condition for each case.

The first step in image interpretation is identification of anatomical surroundings and ligament attachment sites. Once the radiologist is oriented to the region, signal intensity (on a greyscale of 100% black to 100% white) is used as an indicator for identifying the ligament components. In general, ligaments demonstrate low signal intensity however; on some images they may demonstrate intermediate intensity. In addition the deep ligaments, especially the PTTL can demonstrate a striated appearance due to the adipose tissue interspersed between its bundles. If the signal intensity is abnormal compared to other observed normal cases, this could indicate a pathologic condition. Once the ligament is identified, the signal intensity pattern is studied. The pattern is characterized as homogeneous or inhomogeneous and the continuity of the signal is evaluated. The different deltoid ligament components have characteristic signal intensity patterns which allow for component identification if normal and diagnosis if abnormal. Imaging morphology is another characteristic used to identify and evaluate ligaments. The shape on an image can be described as having uniform thickness, or either distal or proximal thickening. The borders of the ligament can be described as being well delineated or blurry. If any of these imaging characteristics appear outside the normal range for that particular ligament component, it may be an indication of a pathologic condition. (intensity, pattern, morphology evaluation from Mengiardi et al.) (Mengiardi et al. 2007, 817-824)
Deltoid Ligament Injuries

It is believed that the deltoid ligament is injured more often than previously thought, but is rarely injured in isolation (Chhabra, Subhawong, and Carrino 2010, 751-761). Injury usually occurs concurrently with distal avulsion fractures, medial malleolar fractures, osteochondral injuries of the talus, lateral ligament and syndesmosis injuries, tibialis posterior tendon and spring ligament abnormalities, and antero/posteromedial impingement syndromes (Cerezal et al. 2003, 551-559). Of all of the components of the deltoid ligament, those of the deep layer are most commonly injured. It is important that the superficial and deep layers be evaluated for injury and categorized separately (Chhabra, Subhawong, and Carrino 2010, 751-761). MR imaging is well suited for this distinction and familiarity with injury imaging patterns allows for accurate diagnoses of injury to the components of one or both of these layers. Ligament injury can be indicated by an abnormal fluid signal, a disrupted, thickened, heterogeneous, or attenuated signal, or abnormality in signal contour (Perrich et al. 2009, 687-695).

Two main classification systems are used to record the characteristics of deltoid ligament injuries in a standardized fashion. Ligament injuries are classified by type and grade. To record the location of the injury, the injury is evaluated to be of type 1 (proximal), type 2 (intermediate), or type 3 (distal) (Chhabra, Subhawong, and Carrino 2010, 751-761). In the general population, it has been found that approximately 70% of deltoid ligament injuries are type 1, only 10% are type 2, and 20% are type 3 (Chhabra, Subhawong, and Carrino 2010, 751-761).

In order to rate the severity, a ligament injury grading system is used when evaluating MR imaging of the deltoid ligament. A grade 1 sprain (mild sprain) is indicated by periligamentous edema and stretching. A grade 2 sprain (partial tear) is indicated by intra-ligamentous fluid-like T2 signal, attenuation or thickening. A grade 3 (complete disruption) is seen as a complete gap in the ligament signal.
**Challenges**

Currently three major needs exist in the area of ankle ligament MR image interpretation training for orthopedic radiology residents:

**Inconsistency/Inaccuracy**

Firstly, there are widespread inaccuracies and inconsistencies in the definitions, terminology, and acronyms used to describe the deltoid ligament (Klein 1994, 377-383). The deltoid ligament consists of multiple components which are mostly continuous and interwoven. Because of its structural complexity and ambiguity, its components are often classified differently and given different abbreviations in related literature. Databases and systems such as RadLex (Langlotz 2006, 1595-1597; Anonymous) and DexNote (Wang, Filice, and Eng 2009, W118-21) have been developed to address these inconsistencies, however consistency must be established in the visual representations of the deltoid ligament as well. In addition, many atlases, textbooks, and three-dimensional teaching models incorrectly represent the structures of the deltoid ligament further adding to the confusion. Most of these references do not adequately communicate the complexity of the deltoid ligament in regards to the structures, thicknesses, and spatial relationships of its components and layers. Many papers attempt to illustrate the spatial relationship of the deltoid ligament components with diagrammatic two-dimensional illustrations, which do not give a comprehensive understanding of the structures. These details are essential to understand in the fields of orthopedics and orthopedic radiology for proper diagnosis and treatment. Therefore, the lack of available accurate anatomical references for the deltoid ligament is a serious concern in these fields. The component definitions used in this thesis are based on studies which define 5 components of the deltoid ligament.

**MR Training Tool Effectiveness and Availability**

The second issue to be addressed is the lack of easily available and effective teaching tools that assist orthopedic trainees in correlating MR imaging of the ankle ligaments with normal and pathological anatomy. Although many of the tools available are interactive interfaces that allow the user to scrub through the MR imaging dataset visually and view labels, they provide no guidance regarding a methodology on how to identify the structures and their pathology. Imaging-to-anatomy correlation tools such as eAnatomy, are available, however they are not always accurate, do not
clearly demonstrate the specific 3D structure being addressed (only the full foot), and rely on the user to navigate and understand the correlation without guidance. DICOM viewing software such as OsiriX and PACS workstations allow residents and fellows to view imaging in many helpful formats, but are also unguided and seldom are able to clearly demonstrate ligament substructures to less experienced or novice trainees.

**New High-Field Image Interpretation**

Lastly, the advances in Hi-Res MR imaging allow for greater detail that has not yet been addressed by the current tools available. 3-Tesla MR provides much greater detail of the small anatomical structures of the ankle than previous lower field MR scans (Chhabra et al. 2012, 164-171). The subtleties shown in Hi-Res ankle MR images are difficult to recognize without the proper training; therefore a tool that assists in the interpretation of these highly detailed datasets would be of great benefit to the field. It is imperative that radiologists be intimately familiar with the complex anatomy of the ankle joint in order to properly diagnose ankle ligament pathologies and make treatment recommendations.

**My Approach**

**Objectives**

The objectives of this project were to:

1. Create a highly accurate 3D digital model of the deltoid ligament
2. Create a 3D animation that:
   a. demonstrates the components of the deltoid ligament and their attachments
   b. correlates High-Field MR images to the 3D structures of the anatomy
   c. illustrates deltoid ligament injury grading/classification and correlates High-Field MR pathological case images to the corresponding 3D representation
3. Create 3D digital dissection models using photogrammetry
4. Create a highly accurate physical 3D-printed model which demonstrates the structures of the ligaments of the ankle.
**Methodology**

The deltoid ligament was chosen due to its complicated structural attachments and vulnerability to undiagnosed pathology and injury. Significant structural variation exists in the deltoid ligaments of patients, making identification of its components on MR imaging challenging. If future funding allows, animations for the lateral and syndesmotic ligaments will be developed.

A three-part 3D animation was created to bridge the cognitive gap between MR images of the deltoid ligament and its three-dimensional anatomy in order to improve the interpretation and diagnostic abilities of orthopedic radiology residents and fellows. Each animation is a guided module that implements the three-dimensional model in order to illustrate the deltoid ligament component anatomy, MR image correlation, or injury grading/classification. Information on normal variation and pathologies is also presented in the animation. Cross sections of the model were used to move between 2D MR images and the 3D anatomy to elucidate spatial relationships. Additionally, a 3D-printed model was created to further elucidate the structures of the ligaments of the ankle.

To ensure the accuracy of the digital and physical models, cadaveric specimens were CT and MR scanned, dissected, and photographed as reference. Multiple anatomical atlases, surgical texts, and journal manuscripts were consulted to ensure that commonly observed variation and pathologies were accounted for.

**Anticipated Benefits**

This project is the first tool to focus on improving High-Field ankle ligament MR image interpretation and spatial understanding via animation and 3D digital and printed models.

The anticipated benefit of this project is improvement in the abilities of orthopedic radiology residents and fellows to more accurately:

- Understand the structure of the deltoid ligament
- Identify the component structures of the deltoid ligament on MR imaging
- Distinguish between normal variation and abnormal pathologies on MR imaging
- Recognize the types of pathologies and grade/classification of injury from the images.
MATERIALS AND METHODS

**Project Approach**

In order to fully understand and represent the deltoid ligament complex, this project was designed to have three main parts. Firstly, dissection was conducted and documented in order to more thoroughly understand the deltoid ligament complex’s structures and attachments (Unpreserved dissection was conducted after CT and MR scanning). Secondly, photogrammetry was used at different stages of dissection in order to capture digital dissection models. Thirdly, a detailed digital model, animation, and 3D-printed model were created using a combination of unpreserved cadaver CT and MR data, 3D laser scan data, and photos using the previous dissections and literature as references. In order to guide the direction and coordinate the logistics of this project, multiple meetings and appointments were scheduled.

**Meetings and Communications**

Based on individual availability, weekly meetings were held with the members of the thesis advisory team which included Dr. John Carrino, Dr. Kenneth Wang, David Rini, Dr. Gaurav Thawait, and Solomon Abay. During these meetings and via numerous emails project scope and direction, scheduling, and updates were discussed. The terminology to be used throughout the project was addressed, both for consistency within the project and to conform to the ontological standards currently being established. Separate meetings were arranged for MR case reviews in order to develop the MR image reading skills needed, gain deeper knowledge of the deltoid ligament, and understand the interpretation approach taken by musculoskeletal radiologists. The specific audiences for each product of this project were discussed so that the information and vocabulary presented would be at the appropriate level. Before confirmation of the availability of unpreserved specimens, other options for acquiring matching MR and CT datasets for the animation was discussed. After scanning the specimens, a meeting was held specifically to choose the MR images to be used in the animation from the unpreserved cadaver scans. Future use of the assets created for this project as well as possible continued directions were discussed.
SOFTWARE AND EQUIPMENT

Software:

- Adobe Illustrator
- Adobe Photoshop
- Adobe Bridge
- Adobe Camera Raw
- Adobe Audition
- Autodesk 123DCatch
- OsiriX
- Pixologic ZBrush
- Maxon Cinema 4D
- Adobe After Effects
- Adobe InDesign
- Apple TextEdit
- Microsoft Word

Computer:

- MacBook Pro
- MacOSX 10.7.5
- 2.26 GHz Intel Core 2 Duo
- 8 GB 1067 MHz DDR3 RAM
- 1Tb HD
- Dual Screen Setup (Samsung SyncMaster T24B350)

Audio Equipment:

- MXL 2001 (David Royer tube modification)
- Apoge ONE audio interface
• Adobe Audition
• Microphone stand
• Pop filter
• XLR cables

**Part 1: Dissection**

For the dissection portion of this thesis, four preserved and two unpreserved lower extremity specimens were acquired for dissection. The preserved specimens were procured from cadavers already in the possession of the Art as Applied to Medicine Department for another course. The structures of interest in the lower extremities of these cadavers were in relatively untouched condition, allowing them to be used for this study. Miguel Schoen led the first two preserved specimen dissections. Solomon Abay contributed his time and expertise throughout the preserved dissections as well. The unpreserved specimens were acquired from the Maryland State Anatomy Board. Upon receipt, the specimens were CT scanned and placed in refrigeration. They were removed thirty-six hours later, MRI scanned, and then dissected by Dr. Benjamin Stein. The unpreserved specimens were consistently handled with proper biohazard precautions and returned to the Maryland State Anatomy Board following dissection. The planned approach to dissection was to:

- Document dissection with photos
- Observe surrounding structures and spatial relationships while exposing the deltoid ligament complex
- Identify the five components of the deltoid ligament complex
- Observe the morphologies, attachment sites, and thicknesses of the components of the deltoid ligament
PHOTOGRAPHIC DOCUMENTATION

Throughout each of the dissections, digital photos were taken to document the steps and structural surroundings related to the deltoid ligament. Photos were taken using a Canon PowerShot SX260HS in JPEG format at a resolution of 4000X3000 pixels. The camera settings used were Auto ISO, a 1/100 shutter speed (auto aperture), fluorescent light white balance, whole scene auto-exposure, and autofocus (normal or macro). A flood light was placed above the work area to improve visibility of the structures.

EXPOSING THE DELTOID LIGAMENT COMPLEX

In order to expose the deltoid ligament, multiple structures were removed, reflected, or retracted during the dissection. The initial incision was made through the skin and superficial facia from the calf to the ball of the foot. The skin and connective tissue were released and reflected to expose the deep fascia. Superficial nerves and vasculature were transected to allow reflection of this tissue. The flexor retinaculum was identified and then incised to expose the synovial sheaths and septa through which the tendons of the tibialis posterior, flexor digitorum, and flexor hallucis longus ran. The septa were then removed to expose the deltoid ligament. Throughout the exposure of the deltoid ligament complex, the spatial relationships to the surrounding and overlying structures were observed. Special attention was paid to the synovial capsule, its margins, and its relationship to the ligament components.

IDENTIFYING THE FIVE COMPONENTS OF THE DELTOID LIGAMENT COMPLEX

In order to identify the different components of the deltoid ligament complex, the proximal and distal attachments were palpated. The components were then separated using a probe, observed and photographed (Fig.1). Colored paper clips were used to mark the various components. (Fig.2)

OBSERVING LIGAMENT CHARACTERISTICS

The attachment sites were observed by removing the connective tissue superficial to the ligament at its proximal and distal attachments. On two of the specimens, the lateral side of the ankle mortise was released of all attachments. This allowed the tibia and fibula to be reflected medially, opening the talocrural joint and allowing direct observation of the deltoid ligament from within
Figure 1. Preserved dissection demonstrating deep (left probe) and superficial (right probe) layers.

Figure 2. Preserved dissection demonstrating TCL (green), TSL (red), and TNL (white) components.
Figure 3. Preserved dissection demonstrating tibia and fibula reflected medially.

Figure 4. Preserved dissection demonstrating PTTL attachment site.
Figure 5. Unpreserved dissection demonstrating flexor retinaculum.

Figure 6. Flexor retinaculum incision in unpreserved dissection.
Figure 7. Retraction of tibialis posterior tendon in unpreserved dissection.

Figure 8. Unpreserved dissection after tendon removal.
Figure 9. Unpreserved dissection demonstrating TNL (probe), TSL (probe), and TCL (hemostat).

Figure 10. TNL identified in unpreserved dissection.
the joint capsule (Fig.3). After observing their intact morphologies, the ligament components were sectioned in order to observe their thicknesses. Attachment sites were also observed after the ligament components were sectioned (Fig.4). The unpreserved dissection was conducted in a more direct manner to quickly expose the deltoid ligament (Figs.5-10).

**Part 2: Dissection Photogrammetry Models**

Autodesk 123D Catch was used to create 3D photogrammetry models of the dissection specimens from sets of photos taken. The guidelines provided by Autodesk for photographing the subject were expanded upon in order to produce the cleanest 3D models possible. The planned approach to the digital dissection model creation was to:

- Refine photogrammetry capture technique and capture dissection specimen
- Create high quality photogrammetry models of the dissection using 123D Catch
- Clean up the raw models in ZBrush
- Create QTVR files using C4D that can be opened by anyone using Quicktime software
- Use digital dissection models as reference for sculpting ligaments for final model

**Photogrammetry Capture**

**Specimen and Shooting Area Setup**

The specimen was placed on a tray with a grey absorbent pad under the specimen. (Fig.11) The tray was placed on a stool and a circular shooting area with a radius of 5-6 feet was cleared around it. The specimen was placed in a position such that it would remain completely still throughout the shoot. Wetting solution was not used for 5 minutes prior the shoot in order to minimize reflections. Untextured, reflective, transparent, and exactly repeating surfaces were avoided. A large piece of plain brown cardboard was used as a background, which a colleague held and rotated around the specimen opposite to the camera during the shoot. (Note: Using a moving background in this way creates a very clean and detailed model because the photogrammetry algorithm does not need to compute image information from the room. When using this technique it is very important to include the flat base surface in the photos.) An overhead soft clip light was
Figure 11. Photogrammetry photo shoot setup.

Figure 12. Autodesk 123D Catch launch button.
used in addition to the lab's fluorescent lighting to light the object evenly. Shadows and reflections were minimized and the window blinds were closed in the lab. The flash on the camera was disabled. (Note: Dark shadow cause flattened areas in the geometry of the model created due to the lack of texture information.)

**Shooting**

Three rings of approximately 20 pictures each were taken from approximately 60, 30, and 0 degree angles from the level of the tray in clockwise direction moving from top ring to bottom. The pictures were taken from a distance of at least four feet away. (Note: Shooting from this distance minimizes lens distortion, resulting in a more accurate model.) The entire absorbent pad base was included in as many shots as possible. For some of the specimens, a closer ring of detail shots was taken from a 45 degree angle from the level of the tray. The camera settings used when photographing the dissection were also used for the photogrammetry capture process.

**Photogrammetry Digital Model Creation**

**Photo Preparation in Camera Raw**

Each photo set was opened in Camera Raw. Duplicate and poor quality images were removed. Exposure and saturation was adjusted to best show texture detail. Adjustments were made to all photos simultaneously first and then for each photo if necessary in order to achieve consistency. The adjusted sets of photos were saved in a new folder with sequential numerical file names. (Note: Camera Raw is an extremely efficient tool for editing and renaming large batches of photos.)

**Creating Photogrammetry Model with 123D Catch Web App**

To create the model, the photos were uploaded to the online app at www.123Dapp.com (Fig.12). A new account was created and the 123D Catch app was launched (Apps tab > Launch 123D Catch Online). The Create New Project window was opened (Start a New Project button). The photos were dragged into the window to upload them. Once the upload was complete, a high-resolution model was set to process (Resolution>High, Process Capture button). Once the gear icon over the photo changed to a check icon, the model was opened and checked for quality.
MODEL MODIFICATION AND QTVR EXPORTING

Cleanup in ZBrush

To download the model, it was selected from the Models page. From that model's page (Fig.13), the OBJ file and JPG texture map were downloaded (Details > .obj link). The OBJ file was then imported into ZBrush (Tool > Import > file name). The texture file was imported (Texture > Import > filename). To orient the texture map correctly, the V coordinates were flipped (Tool > UV > Adjust UV > Flip V). The geometry was checked for blatant errors, and corrected if necessary with the sculpting brushes. The model was subdivided once to smooth out any harsh geometry. It was then trimmed by selecting the areas to be kept with the SelectRect selection tool (cmd+shift+drag) and then deleting the removed geometry (Tool > Geometry > Modify Topology > Del Hidden). The model was then exported as an OBJ by first setting the scale to 1, x, y, and z positions to 0, and turning on the Flp button in the export settings (Tool > Export). The OBJ and PSD texture map were then exported (Tools > Export).

Texture Mapping, Lighting, and Exporting from Cinema 4D

The model was then imported into Cinema 4D (Object Manager Window > File > Merge Objects). A new material was created and the texture map was added to the color channel. If necessary, the texture was flipped vertically in Photoshop using the edit image button. (Note: ZBrush imports and exports UV and texture maps upside down.) The luminance channel was enabled and the main color changed to black. The texture map was added to the luminance channel and the brightness of the luminance channel was brought down to 10% (Fig.14). (Note: If this slight luminance is not added, the model appears very desaturated and necrotic in renders.) To light the model, a key light and fill light were added to the scene. A QTVR was rendered (Render Settings > Save > Format > Quicktime VR Object). Under the Quicktime VR options, the default settings were used except the start angle, which was changed from 90° to 0°, and the horizontal steps, which were changed from 36 to 72. The QTVR was then rendered and saved using the picture viewer. (Note: The start and end angles in the QTVR settings refer to the angle to which the camera is pointing, not its position relative to the object.)
Figure 13. Photogrammetry model OBJ exporting link.

Figure 14. Texture map image applied to material color and luminance channels in Cinema 4D.
Part 3: Model and Animation

A detailed model and animation of the deltoid ligament were created using various software packages. Multiple production stages were involved in the creation of these final assets. The planned approach to the deltoid ligament model and animation creation was to:

- Write a narration based on literature, dissection observations, and communication goals
- Create an animation storyboard in Illustrator
- Acquire 3D surface laser scan data sets of dry lower extremity bone specimens
- Acquire CT and MR scan data sets of unpreserved cadaveric ankle specimens
- Export surface renders of the ankle CT data scans using OsiriX
- Clean up the meshes in MeshLab
- Create new repaired, sculpted, and textured models of the bones and ligaments in ZBrush
- Create low-resolution animatic and final 3D animation in Cinema 4D
- Complete animation with MR images, dissection photos and labels in After Effects

Narration

After a thorough literature review, a narration was written to communicate the main goals discussed in the meetings. The narration was broken up into 3 sections: Anatomy of the Deltoid Ligament Complex, MRI Correlation, and Injuries. The narration was then edited by the members of the advisory team for accuracy and clarity. A scratch narration was recorded using Audition software and the equipment listed below to establish initial timing. After the animatic and all final narration changes were completed, the final narration was recorded using the same equipment. The file type used for all audio recordings was WAV format at 48kHz sample rate and 24-bit depth. The following recording equipment was used:

- MXL 2001 (David Royer tube modification)
- Apoge ONE audio interface
- Adobe Audition
- Standard microphone stand, pop filter, XLR cables
**Storyboard**

Using the narration as a guide, the storyboard was created in Illustrator. Still images for each shot were rendered using a low-resolution model created in ZBrush from a sample OsiriX data set. To create the still images, a surface render was exported from OsiriX in OBJ format, cleaned in Meshlab, imported into, trimmed, and sculpted in ZBrush, and imported into, textured, and lit in C4D by the same method described for the main digital model created for this project. A storyboard template was created on an artboard in Illustrator and then duplicated. The still images were sized and arranged on the storyboard. Highlights, labels, and descriptions were then added using Illustrator’s pencil, path, and text tools. The storyboard was referred to throughout the planning and animation processes.

**3D Surface Laser Scanning**

Three-dimensional surface laser scanning was used to capture the bone surface detail used in the final digital model (Fig.15). A right set of lower extremity (tibia, fibula, tarsals, metatarsals, phalanges) dry bone specimens were scanned at Direct Dimensions Inc. using a FARO Laser ScanArm in conjunction with InnovMetric’s Polyworks Software (Fig.16). A scan resolution of 0.25mm was used to capture extremely high detail. The foot bones were first scanned together in their monofilament articulated assembly for later reference. The bones were then disarticulated systematically and scanned individually. Many bones were placed on measurement blocks in order to scan the specimens from lower angles.

**CT Scanning**

For CT scanning, an extremity cone beam CT prototype unit (Carrino et al. 2014, 816-824) was utilized. Due to the limited field of the unit, two separate scans (proximal foot and distal foot) were conducted to capture the necessary anatomical structures. The scans were conducted with the foot in as close to neutral position as possible. Throughout the handling and the scanning process, multiple layers of sealed bags were used to conform to proper biohazard safety precautions.
Figure 15. Three-dimensional surface laser scan of tibia.

Figure 16. Polyworks software constructing point cloud model.
Figure 17. MR scan of unpreserved specimen.
MR Scanning

A 3T MAGNETOM Skyra (Siemens Medical Systems, Erlangen, Germany) MR scanner unit was utilized for MR imaging (Fig.17). Multiple intermediate-weighted/proton density and 3D-SPACE sequences were executed with and without fat saturation in the coronal, axial, and sagittal planes with the foot in as close to neutral position as possible. The same biohazard safety precautions followed during CT scanning were followed during MR scanning.

Surface Render and QTVR Export from OsiriX

OsiriX was used to:

- Trim the CT data to maximize quality and clarity of the bone surface renders, while minimizing the need for post-export trimming
- Quickly find ideal pixel settings to create highest resolution surface render with cleanest, unprocessed detail that the software and hardware can manage to export
- Export bone surface renders as OBJ files
- Export multi-tissue volume renders as QTVR files

Trimming

To create the surface rendering, the CT DICOM data set folders were copied into OsiriX. The first dataset of the distal foot was opened in the 2D viewer. To trim away excess data, a volume render was created (3D Viewer > Volume Render). The 16-bit mode was activated (16-bit button) and shading was turned off. The histogram was adjusted to show the surface of the bag in which the specimen was wrapped. The scissor tool was then used to trim away excess data to ensure a clean surface render (Fig.18).

Surface Render

A surface render was created (3D viewer > Surface Render) (Fig.19) with decimation and smoothing turned off and the resolution set to the 2nd lowest mark. Pixel values for the first surface were tested by adjusting them by values of 100 and then in consecutively halved increments (by 50, 25 etc) as the results improved in order to obtain the cleanest desired surface shape (Fig.20). For this data, the optimum pixel value was found to be 75 which allowed for the cleanest
Figure 18. Trimming CT volume render with the scissors tool in OsiriX.

Figure 19. Selecting the 3D Surface Rendering option.
Figure 20. Adjusting the surface render settings

Figure 21. Selecting the Export QTVR option.
shape without attached noise artifacts. The resolution was then increased two increments at a time. As the resolution neared half way on the slider, OBJs were exported at increasing resolutions as a safeguard (Export 3D-SR > Export as Wavefront (.obj)). This process was repeated with the more proximal CT data set of the ankle region.

**Volume Render QTVRs**

To create the Volume Render QTVRs, The histogram was adjusted to best display the bone within the soft tissue. A QTVR was then exported (Arrow > Export QTVR button)(Fig.21). The settings for the QTVR were set to Type: 3D Rotation - 1,600 frames, Quality: Current Rendering Quality, and Size: 768X768 (Fig.22). After rendering, the video compression was set to H.264 at best quality. The other settings were used at their defaults (Fig.23). The QTVRs were then checked in Quicktime (Figs 24,25).

**Cleaning of Polygon Mesh in Meshlab**

Meshlab was used to:

- Clean up the surface renders by removing all small meshes caused by signal noise and artifacts created in the rendering process in OsiriX

Each CT data set was imported (File > Import Mesh). The mesh was then cleaned (Filters > Cleaning and Repairing > Remove Isolated Pieces (wrt Diameter)) (Fig.26). The diameter size percentage was changed to 10% and then applied (Fig.27). A second cleaning was applied at 5%. The mesh was then exported as an OBJ file (File > Export Mesh As > Alias Wavefront Object (.obj)).
Figure 22. Adjusting QTVR render settings.

Figure 23. Adjusting QTVR compression settings.
Figure 24. Distal QTVR exported from OsiriX.

Figure 25. Proximal QTVR exported from OsiriX.
Figure 26. Selecting the Remove Isolated pieces (wrt Diameter) function in MeshLab.

Figure 27. Adjusting the Remove Isolated Pieces (wrt Diameter) settings.
Creation of Model in ZBrush

ZBrush was used to:

- Further clean the surface renders by trimming away excess
- Separate each of the bones for repair
- Create new watertight, well topologized, detailed meshes of each of the bones using Dynameshing and Projection
- Create single bone model by combining proximal and distal CT scan data
- Create ligament and synovial capsule models based on bone model
- Create multiple versions of the new model at different poly counts
- Export low-resolution model for animatic
- Create final detailed model with multiple subdivisions and UV, texture, and normal maps
- Export final model for animation

Importing

Each surface render OBJ (proximal and distal) was manipulated in ZBrush as separate files until the new clean versions were ready to be combined into single model. The proximal OBJ file was imported first into ZBrush (Tool > Import). OK was clicked when the unused vertices deleted message appeared. Double-sided visibility was turned on (Tool > Display Properties > Double). Throughout the process, polyframe visibility was toggled on and off (shift+f).

Decimation

The Decimation Master plugin was used to bring the polygon count down to a more workable size. First, the mesh was preprocessed at 50% decimation (Zplugin > Decimation Master > Pre-process All) (Fig. 28). After processing it was decimated. (Decimate All button) (Fig. 29). This process was repeated at 50% one additional time.
Figure 28. Preprocessing for decimation.

Figure 29. Decimating at 50%.
Trimming

To trim excess data the hide selection lasso (cmd+opt+shift+drag) was used (Fig.30). Once all of the desired trimming was complete, the hidden geometry was permanently deleted (Tool > Geometry > Modify Topology > Del Hidden). The holes in the mesh were then closed (Close Holes button) (Figs.31,32).

Splitting Bones Into Separate Subtools

Each of the bones was split into a separate subtool for repair. Auto Polygroups was executed (Tool > Polygroups > Auto Groups). The polygroups created were then split into separate subtools (Tool > Subtool > Split > Groups Split). Bones that merged together erroneously were separated by carefully using the lasso selection tool (cmd+shft+drag around selection) and inverting selections (cmd+shft+drag on background) to isolate one of the bones and then splitting them into separate subtools (Tool > Subtool > Split > Split Hidden) (Figs.33,34). Each bone subtool was then renamed and duplicated by clicking the corresponding buttons in the subtool palette. The duplicate was renamed with “New” in the name to distinguish it as the subtool that will become the new version of that bone.

Repair and Projection

To repair the CT surface render, projection was utilized. The new subtool version of each bone was Dynameshed at a low-resolution (Tool > Geometry > Dynamesh > Dynamesh) (Figs.35,36). The optimum resolution for each bone was found by trial and error in order to achieve a new mesh that conformed to the overall form of the bone. This value was usually between 16 and 200 depending on the size and mesh damage. (Note: This low-resolution mesh was used as a sort of digital filler putty and shaped to fit the damaged bone by sculpting and projection.) Before projecting, every subtool but the new mesh and damaged mesh were hidden. The Move Topological, Inflate (and Deflate by holding opt), and Smooth brushes were used to adjust the new low-resolution version to fit the general form of the damaged bone closely. The projection settings were then accessed (Tool > Subtool > Project) and a distance of 0.1 and a 50% blur were used as starting settings. The projection shell was then set using the corresponding slider until the shell covered all the surface geometry of the damaged bone subtool. (Note: The projection shell determines which surfaces will be projected to, while the distance setting determines how far geometry will move.
Figure 30. Hiding unwanted geometry with the selection lasso in ZBrush.

Figure 31. Geometry prior to Close Holes operation.  Figure 32. Geometry after Close Holes operation.
Figure 33. Medial cuneiform mesh hidden and split into a separate subtool using Split Hidden function.

Figure 34. Medial cuneiform mesh as separate subtool.
Figure 35. Suboptimal CT surface render calcaneus mesh with complex inner branched geometry.

Figure 36. Low resolution Dynameshed duplicate mesh.

Figure 37. Subdivided and projected duplicate mesh.

Figure 38. Duplicate mesh with original mesh hidden.
toward that new surface.) The low-resolution mesh was then projected (Project All button). The low res mesh was subdivided, adjusted with the same brushes used previously and then reprojected using a distance setting of 0.05 after readjusting the projection shell (Figs.37,38). This process was repeated with a distance setting 0.025, and then 0.01 repeatedly until the polygon count for the newly formed subtool was between 10k and 50k for each of the smaller bones and between 50k and 200k for each of the larger bones (Figs.39-46).

**Merging and Exporting the New Repaired Bones**

After saving a new version of the project file, the original damaged bone subtools were each selected as active (arrow keys) and then deleted (Tool > Subtool > Delete). This left only the newly formed, repaired, and clean topology versions. To ensure that each subtool was a single polygroup prior to merging, each subtool was selected as active (arrow keys) and then made a single polygroup (Tool > Polygroup > GroupVisible). All of the repaired bone subtools were then merged into a single subtool (Tool > Subtool > Merge > MergeVisible) ensuring that the weld button was not turned on. To ensure separate polygroups, Auto Polygroups was used (Tool > Polygroups > Auto Groups). The merged bones subtool was then Dynameshed at 2048 resolution. In the export settings (Tool > Export), position and scale values were left as they were and, ensuring that only the Grp and Qud buttons were enabled, the OBJ was exported (Tool > Export button). All of these steps were repeated for the distal CT surface render OBJ to prepare it for merging with the proximal model. (Note: When working with data-based meshes that are to be combined within ZBrush, it is critical not change the export scale or position settings prior to merging. This ensures that one will import into the other at the correct scale and position.)

**Merging Proximal and Distal Meshes**

To merge the proximal and distal lower extremity bone meshes together, the proximal model was chosen to be the stationary base model. The proximal merged bones tool was opened and a star polymesh was appended (Tool > Subtool > Append > PolyMesh3D(Star)) (Fig.47). With the star subtool selected, the distal merged bones OBJ file was imported (Tool > Import), which replaced to star polymesh (Fig.48). The transpose tool was then used in move and rotate mode to position the distal merged bones subtool into the correct position (Figs.49,50). At certain points the tarsal bones on the proximal model were hidden (cmd+shift+click) to assist the alignment of
Figure 39. Duplicate mesh formed more closely to original mesh.

Figure 40. Subsequent mesh subdivision and projection.

Figure 41. Projection shell prior to adjustment.

Figure 42. Projection shell after adjustment.
Figure 43. Subsequent subdivision and projection. Figure 44. Projection shell after adjustment.

Figure 45. Subsequent subdivision and projection. Figure 46. Repaired calcaneus mesh.
Figure 47. Star subtool appended in preparation for distal mesh import.

Figure 48. Distal mesh imported.

Figure 49. Position adjustment with Transpose tool in Move mode.

Figure 50. Position adjustment with Transpose tool in Rotate mode.
the distal subtool. (Note: None of the bones of the distal subtool were hidden as this would move
the bones within the subtool relative to each other.) The subtools were then examined for dam-
aged areas and which subtool (proximal or distal) had the most desirable geometry for that area.
The bones from each subtool to be used were isolated by hiding them (cmd+shift+click) and then
using the Split Hidden button (Tool > Subtool > Split > Split Hidden). The two isolated subtools
to be merged were made visible and the damaged areas of each were hidden (cmd+shift+click)
and deleted (Tools > Geometry > Modify Topology > Delete Hidden) (Figs.51,52). The ZProject
brush was then used to conform the inaccurate surface areas of each subtool to the accurate one
by alternating which subtool was active (Fig.53). The two subtools were then merged by select-
ing the top subtool as active (arrow keys) and then merging down (Tool > Subtool > Merge >
Merge Down) with the Weld button on. The new mesh was then Dynameshed (Tool > Geometry
> Dynamesh) at the Same, Group, and Project buttons on. The merged proximal bones subtool
was then made visible (eye icon) and merged with the new repaired subtool (Tool > Subtool >
Merge > Merge Visible) (Figs. 54-56) with the Weld button off. (Note: The weld button deter-
mines whether meshes being merged become a single connected mesh or separate meshes within
the new subtool.) Finally, because the cadaver foot was slightly plantar flexed during the CT scan,
the positions of the tibia and fibula were moved into a more neural position. The tibia and fibula
were hidden by polygroup (cmd+opt+shift+click), split into a different subtool (Tool > Subtool >
Split > Split Hidden), rotated using the Transpose tool in rotation mode. The axis of the Transpose
tool was aligned to the natural axis of the talar trochlea and the middle transpose ring was used to
rotate the tibia and fibula into neutral position.

Low-Resolution Versions of Bone Model

To create multiple different low-resolution versions of the bone model for the animatic and
final animation, Dynamesh and ZRemesher were used. The full resolution subtool was duplicated
(Fig.57). The duplicate was Dynameshed (Tool > Geometry > Dynamesh) at full 2048 resolution
with the Group and Project buttons on (Figs.58,59). This mesh was duplicated and ZRemeshed
(Tool > Geometry > ZRemesher) at a Target Polygon Count of 100, with the Adapt button on,
and Adaptive Size and Curve Strength both set to 0 (Fig.60). The Dynameshed subtool was then
duplicated and Dynameshed again at a resolution of 176. This version was then duplicated and
Figure 51. Utilizing masking with the Transpose tool to isolate unwanted geometry.

Figure 52. Unwanted geometry hidden and deleted.

Figure 53. Masking active mesh in preparation for projection onto other mesh using ZProject brush.

Figure 54. Repaired metatarsal 5 mesh merged with original distal mesh subtool.
Figure 55. Merged proximal and distal meshes.

Figure 56. Merged proximal and distal meshes.
Figure 57. Duplicate of high polycount repaired mesh prior to Dynameshing.

Figure 58. Dynameshed duplicate mesh.
Figure 59. Dynameshed duplicate superimposed on full-resolution repaired high polycount mesh.

Figure 60. ZRemeshed duplicate of the mesh.
**ZRemeshed** with the *Half* button on. The low-resolution *Dynameshed* subtool was chosen for the animatic due to its higher textural detail at low-resolution compared to the *ZResmeshed* version. The *Dynameshed* merged bones subtool was exported (**Tool > Export button**) with the Qud, Flp, Mrg, and Grp buttons enabled in the Export settings (**Tool > Export**).

**Positioning Models for Proper Transfer Between ZBrush and Cinema 4D**

In order to ensure proper positioning and orientation of future model exports from ZBrush into Cinema 4D, the low-resolution foot model was exported (**Tool > Export button**) with a scale of 1, x,y,z positions of 0, and with the Qud, Flp, Mrg, and Grp buttons enabled (**Tool > Export**). The low-resolution model was then imported into Cinema 4D (**Object Manager > File > Merge Objects**). The model was rotated into the position desired for the animation using the rotate tool (**r**). The project file was saved (**Main Menu > File > Save**) and the mesh was exported (**Main Menu > File > Export > Wavefront(*.obj)**). The ZBrush file with the bone models was reopened and a star polymesh was appended (**Tool > Subtool > Append > Polymesh3D(star)**). The OBJ exported from C4D was imported (**Tool > Import button**) to replace the star. All of the other subtools were then aligned to this imported model using position and rotation deformation (**Tool > Deformation**) and the transpose tool (**Figs.61,62**). (Note: This process allowed for much faster OBJ file transfer between ZBrush and Cinema 4D in the event of edits or additions to the model. GoZ is an experimental feature that automatically aligns and transfers OBJs between these programs, however it did not work properly for this project.)

**Sculpting the Deltoid Ligament Complex**

To sculpt the ligament components of the deltoid ligament, *ZSpheres*, the *ZProject* brush, and other brushes were utilized. The low-resolution *Dynameshed* bones subtool was used as a guide by cloning it into another tool (**Tool > Clone**). (Note: It is often easier to work in a new tool so that subtools can be easily manipulated in a less crowded working environment. Once completed, the new component can be imported back into the original tool. This also prevents accidental damage to valuable subtools of the main tool.) Ghosting was turned on (**ghost button**) and a *ZSphere* was appended (**Tool > Subtool > Append > ZSphere**). The *ZSphere* was sized (**Deformation > Size**) and positioned (**Transpose tool** (**Fig.63**). Two other *ZSpheres* were added (**Standard brush in Draw mode**) to the main sphere at each pole to ensure proper skinning which was previewed (**a**).
Figure 61. Alignment of current ZBrush mesh to Cinema 4D imported mesh.

Figure 62. Alignment of current ZBrush mesh to Cinema 4D imported mesh.
Figure 63. ZSphere appended as subtool and sized.

Figure 64. PTTL mesh created from ZSphere.
For most of the ligaments, two of the ZSpheres were used to create the elongated shape, while the third was left small and on the surface of the main sphere. While in skin preview mode (a), a mesh was created from the ZSphere skin, (Tool > MakePolymesh3D) and appended (Tool > Subtool > Append > PM3D_ZSphere) (Fig.64). The original ZSphere subtool was then deleted (Tool > Subtool > Delete). The new skin subtool was then subdivided (cmd+d) and quickly shaped by cutting away large portions of geometry using the TrimLasso selection tool (cmd+shift+click selection tool) (Figs.65-67). The direction and size of lassoing was used to remove or preserve areas of the mesh. (Note: The TrimLasso Selection tool is an efficient way to rapidly achieve the desired form, acting like a clay wire or knife that removes unwanted material. That being said, sometimes making the desired selection can be problematic. In general, clockwise lasso selections preserve the enclosed geometry while counterclockwise selections delete it; however this sometimes changes due to the size of the selection relative to the mesh. For certain meshes, multiple smaller selections were removed to achieve the desired shape.) The general shape of the ligament component was sculpted using Dynamesh (Tool > Geometry > Dynamesh) at low-resolutions and the Move Topological, Smooth, and Flatten brushes (Fig.68). (Note: Using the Move Topological brush with a large brush size and Focal Shift of 0 allows for very smooth and natural deformations of meshes)

In certain cases, the transpose tool was used to mask large areas of the mesh evenly (cmd+drag on model with transpose tool) and blurred (cmd+click on mesh). The other ligament meshes were created in the same manner (Figs.69-71). The ligament attachment sites were sculpted to the exact form of the bones by selectively hiding most of the bone subtool with the selection lasso (cmd+shift+drag), allowing access to the ligament from an inside view of the bone mesh (Fig.72). The ZProject brush was then used in Zadd and Zsub mode with Backface Masking on (Brush > Auto Masking > Backface Mask) and with a focal shift of 0 (spcbar > focal shift) (Figs.73,74). (Note: The ZProject brush acts similarly to the Project button, however it allows greater control over what areas of the mesh are projected and how strongly. By working from the inside of the bones, the brush is basically instructing the vertices and polys to move to the nearest visible surface of other subtools, which in this case, is the bone surface. By this method, the surface of the ligaments can be made to exactly match the surface of the bones.) Smoothing was also used with Backface Masking toggled on or off depending on the mesh area. (Note: Smoothing with Backface Masking disabled allows the smoothing of spiked geometry and geometry around corners but can cause prob-
The **TrimLasso** brush will apply a lasso stroke to the surface, deleting all geometry that is within the lasso then applying the close hole algorithm to close off the surface.

This brush will not work symmetrical.

Button path: Brush:TrimLasso

Figure 65. Trim Lasso selection tool.

Figure 66. Trimming PTTL mesh with TrimLasso selection tool.
Figure 67. Trimmed PTTL mesh.

Figure 68. Dynameshed and smoothed PTTL mesh.
Figure 69. ATTL mesh created from ZSpheres.

Figure 70. Trimming ATTL mesh with TrimLasso selection tool.
Figure 71. ATTL mesh after trimming.

Figure 72. Desired bone area geometry after selection with the Lasso selection tool.
Figure 73. Projection of ATTL mesh onto bone surface from inside using ZProject brush.

Figure 74. Projection of PTTL mesh onto bone surface from inside using ZProject brush.
lems on very thin mesh edges. For this reason, Backface Masking was turned on whenever working with thin edges that needed to be preserved.) Projection and smoothing were alternated multiple times until the correct attachment shapes were achieved. The Inflate, Flatten, and Move Topological brushes as well as ZRemesher were used to refine the ligament components to their final shape (Figs.75-77). (Note: ZRemesher can handle thin meshes much better than Dynamesh.) Each component was created as a new subtool and previous ligaments were left visible to ensure the proper spatial relationships between them (Fig.78). Once all of the components were complete, each ligament subtool was then selected as active and each made into a single polygroup (Tool > Polygroups > Merge Visible). (Note: The TrimLasso selection tool creates a new polygroup with each cut and therefore multiple polygroups existed within each ligament subtool.) The ligament subtools were then all made visible (eye icon), the bone model was hidden (eye icon) and merged (Tool > Subtool > Merge > Merge Visible). The individual ligament subtools were deleted (Tool > Subtool > Delete). The new merged ligament subtool was then appended (Tool > Subtool > Append > filename) to the tool containing the multiple versions of the CT-based bone model (Fig.79).

Sculpting the Synovial Capsule

The talocrural synovial capsule was created by first cloning (Tool > Clone) the Dynamesh medium resolution foot model into a new tool to have a clean workspace. Then a ZSphere skin was created, similar to the ligament workflow, but larger and covering the entire joint between the tibia, fibula, and talus (Figs.80-81). The bone was hidden (eye icon) and the ZSphere skin was made into a single polygroup (Tool > Polygroups > Group Visible). The medium resolution bone subtool was then duplicated (Tool > Subtool > Duplicate) and moved below the ZSphere skin subtool (Tool > Subtool > angle arrow button). The subtraction merge option was selected (subtraction rings icon) for the duplicated bones subtool and the original bone subtool was hidden (eye icon). The capsule shape was then created by remeshing (Tool > Geometry > Remesh All) with symmetry deactivated, a resolution of 128, and a polish of 10 (Fig.82). (Note: The remeshing shown was done with PolyGrp button enabled causing polygroups to be created based on the areas subtracted (Fig 83). Normally the PolyGrp button can be disabled.) The capsule was then trimmed, Dynamesh, projected, and sculpted with the same techniques used on the ligaments (Figs.84-86). Once the
Figure 75. TCL mesh after shaping with the Smooth and Move Topological tool.

Figure 76. TCL mesh after flattening with the Flatten brush.
Figure 77. TSL mesh after ZRemeshing operation.

Figure 78. Completed ligament meshes as separate subtools.
Figure 79. Merged ligament meshes in separate polygroups within one subtool.
Figure 80. ZSpheres sized and positioned to create synovial capsule.

Figure 81. Mesh created from ZSpheres.
Figure 82. Remeshing with bones set to subtract from synovial capsule mesh.

Figure 83. Synovial capsule mesh created from subtraction remesh operation.
Figure 84. Shaping synovial capsule with TrimLasso, Dynamesh, and brushes.

Figure 85. Shaping synovial capsule with TrimLasso, Dynamesh, and brushes.
Figure 86. Capsule mesh after sculpting with Move Topological and Smooth brushes.

Figure 87. Capsule mesh ghosted to view relationship to talocrural joint.
final desired shape was achieved, the capsule model was *Dynameshed* a final time at a resolution of 512 and then subdivided to reach a polycount close to 50k. It was then appended to the main Ztool and ghosted to test its positioning (Fig.87).

**UV and Texture Mapping**

In order to create texture and normal maps for the models, a UV map needed to be created first. (Note: A texture map is a color image file in PSD, JPG, or other format that is applied using the UV map for positioning. A UV map is basically a colored mesh coordinate system that tells texture map files how to be positioned on a mesh. OBJ files can have UV information saved in the file itself.) The UV map resolution left at the default 2048 (Tool > UV Map > UV Map Size). The UV map was then created for each model by selecting it as the active subtool and then unwrapping it (Zplugin > UV Master > Unwrap) (Fig.88). (Note: A single UV map can be created for a subtool with multiple polygroups. This allowed a single UV map to be created for the full set of bones in each bone model and a second UV map for all of the ligaments.) To check the UV maps, a texture was created from the UV map on each subtool (Tool > Texture Map > Create > New From UV Map) (Fig.89). The UV texture map was then copied to the main texture menu (Tool > Texture Map > Clone Txtr) and exported as a PSD file (Texture box > Export). (Note: Creating a texture map of the UV map is not essential, however it allows one to check that the texture maps have been applied properly when importing the model into other programs (Figs.90,91).) To create the ligament attachment sites that were to glow in the final animation, texture maps were created for each of the ligament attachments. Because a single UV map was created for the entire set of bones in each model, only one texture map needed to be created for each set of ligament attachments (eg. one PTTL map, one ATTL map, etc.). To create the attachment texture maps, each area of attachment was painted on the bones model with the masking brush (cmd+drag on model) (Fig.92). A texture map was then created from the mask (Tool > Texture Map > Create > New From Masking) (Fig.93). The texture map was then copied to the main texture menu (Tool > Texture Map > Clone Txtr) and exported as a PSD file (Texture > Export) (Fig.94). When exporting, the PSD file was named according to the corresponding ligament component. The texture map was then tested as a layer on the Luminance Channel in Cinema 4D (Fig.95).
Figure 88. UV map creation with UV Master plugin.

Figure 89. Texture map created from UV map.
Figure 90. Exporting low resolution model with UV texture map.

Figure 91. Checking UV Texture Map application in Cinema 4D compared to ZBrush.
Figure 92. Mask painted to create PTTL attachment texture map.

Figure 93. PTTL attachment texture map created from mask.
Figure 94. Exporting PTTL attachment texture map.

Figure 95. PTTL attachment texture map tested as luminance mask in Cinema 4D.
Laser Scan Detail Projection

To incorporate the detailed surface information captured with the surface laser scan of the dry bone specimens, the laser scan meshes were imported and sized to match the CT-based meshes (Fig.96-97). The low-resolution Dynameshed bone subtool was subdivided and projected to conform to the high-resolution Dynameshed CT-based bone mesh utilizing the method described above. (see “Repair and Projection “ in Part 3: Model and Animation section of Materials and Methods) (Note: If the final model requires multiple subdivision levels from the starting base mesh, Dynamesh, ZRemesher, and Remesh functions cannot be used once the projection process begins. The retopologizing done by these functions deletes all previous subdivision information for that subtool.) Once multiple projections were completed, the laser surface scan detail was projected onto the highest subdivision level of the CT-based subtool. To do this, ZProject brush was used in a similar manner as on the ligament meshes at the boney attachment sites, but at a much lower Z Intensity setting. This allowed for a much more subtle transfer of detail without disrupting the forms of the CT-based mesh. The laser scan subtool was repositioned with the Transpose tool throughout this process to align the bone meshes for optimal detail projection (Fig.98). The laser scan meshes were also used to repair missing form data of the CT-based mesh in certain areas (Fig.99-101). Once all of the desired surface detail was transferred to the CT-based subtool mesh, it was set to its lowest subdivision level and a normal map was created. (Note: A normal map allows the lowest subdivision base mesh to appear as detailed as the highest subdivision level when rendered. This technique is critical when using high detail models in animations as the high subdivision mesh contains far too many polygons for most computer processors to handle at a reasonable speed.) Once created, the OBJ and normal map were exported from ZBrush.

Spotlight Image Projection Polypainting

To create the photo-realistic appearance of the final model, the Spotlight feature of ZBrush was used. The actual dry bone specimens were laid out in order, evenly lit, and photographed in groups from orthographic angles. Because of the difficulties in photographing ligament texture, a photo of straight hair was used to simulate ligament fibers. Spotlight was enabled and the photos were imported, sized, and positioned. The Standard brush was then used in RGB mode at medium RGB intensity to transfer the color information onto the model. (Note: Spotlight is an incredi-
Figure 96. CT based mesh (left) and laser scan data mesh (right).

Figure 97. Laser scan data mesh (left) CT based mesh (right).
Figure 98. Aligning laser scan data mesh with CT based mesh using Transpose tool.

Figure 99. Incomplete CT mesh deep within laser scan mesh in posterior calcaneus area.
Figure 100. Using ZProject brush to repair incomplete area of CT based mesh using laser scan mesh.

Figure 101. Repaired posterior calcaneus region of CT based mesh.
bly powerful tool for projecting color or texture information from a 2D photo onto a mesh. The
*ZProject* brush can also perform this task, but from one 3D object to another.) Once the Spotlight
polypainting was complete, a texture map was created from the polypaint and exported by the
same method as the ligament attachment texture maps. (see “UV and Texture Mapping “ in Part
3: Model and Animation section of Materials and Methods) The detailed texture maps were later
applied as textures in the Color channels in the master bone and ligament materials in Cinema 4D.

**Animation in Cinema 4D**

C4D was used to

- Layout timing of animation based on narration
- Animate camera movements
- Animate glowing and transparency ligament effects
- Create cross section and MRI effects
- Animate foot articulations
- Create injury effects
- Create animatic
- Create final 3D animation

**Efficient Animation Setup**

A new Cinema 4D project file was opened to create both the animatic and animation. (Note:
By creating the animatic and final animation using the same project file, all model animation and
camera movement keyframing could be setup once at the outset. After creating and revising the
animatic using low res versions of the models and basic materials, the final models and materials
can be substituted for the animatic versions. This process proved to be more efficient than the
common practice of creating a two dimensional animatic in After Effects.) A render setting preset
was created and saved with minimal options to allow for rapid test renders. The screen size ratio
was set to 16:9 at a size of 400x225. All render options were unchecked except for default lighting,
texture, and transparency. Ray depth was set to 10 to allow multiple overlapping transparent struc-
tures to render correctly. (Note: These render settings allow for rapid test renders in the animatic
stage, usually one second or less per frame.) The display in the main window was set to hidden
lines with an interactive render region positioned over the middle of the window. (Note: When
working with mixed material animation, this display setup was found to be the most efficient way
to work. If Gouraud shading display is used with luminance effects, the materials appear matte
black when not illuminated.) Custom layouts and timeline bookmarks were also saved and utilized
to create a smooth workflow.

Importing Models

The low-resolution merged bone model and ligament models were imported (Object Man-
ager > File > Merge Objects) with the units set to meters (Fig.102,103). (Note: It is important to
import at 1 meter to match the scale of the ZBrush OBJ export. Due to the previous steps taken
to align the models with the C4D OBJ export in ZBrush, all importing of ZBrush OBJ exports
aligned correctly in C4D.) Normals were reversed when necessary (Mesh > Normals > Reverse
Normals). The bone meshes were then grouped into a null and renamed with the appropriate
bone names or abbreviations (Fig.104). The ligaments were grouped into a null and renamed with
the appropriate ligament component abbreviations.

Audio Narration and Markers

In order to time the animated elements of the animation, the narration audio files were
imported into the project. A null was created, dragged to the animation timeline, and selected.
A sound track was added (Timeline > Create > Add Special Tracks > Sound) and selected, and
the audio file was imported (Attributes > Sound). Markers were created (shft+m) and labeled
(dbl click) at sections and cues in the narration to guide keyframing. The All Frames option was
unchecked in the playback rate drop down (film strip icon) to allow smooth audio playback.

Camera

A camera was created and set to have a 50mm focal length (Attributes > Object > Focal
Length) and a parallel projection (Attributes > Object > Projection > Parallel). For alternate
concurrent shots, two other cameras were created in the same manner. A null object was created,
a target tag was added to the camera, and the null object was set as the target. (Note: Setting a null
as the target for a camera allows much smoother and easier control of camera movements. The
Figure 102. Importing merged bones OBJ file exported from ZBrush.

Figure 103. Importing merged ligaments OBJ file exported from ZBrush.
Figure 104. Imported ligament meshes renamed.
camera can be moved freely and the null object and its surroundings will always be in the shot. The camera movements were then creating by setting x,y,z position and zoom keyframes (\texttt{ctrl+-click keyframe circles}). Movements were animated with as few keyframes as possible to create smooth camera movements. (Note: For the smoothest camera movements, setting keyframes for the known stationary shots first, and then as few as possible for the movements in between works best.) The storyboard was referenced as a guide to determine what shots should occur during each part of the narration. Once the camera movements were set, the camera’s position keyframes were all selected (\texttt{ctrl+a}) in the F-Curve timeline and set to zero angle (\texttt{rt click > ZeroAngle(Tangent)}). (Note: setting keyframes to zero angle ensures that the position spline passes through that keyframe horizontally, eliminating swinging movements past the keyframe position set.)

\textbf{Material Animation}

\textbf{Material Hierarchy}

To create and manage the glowing and transparency material effects, a virtual hierarchy of materials was created via distribution of materials to objects. All materials were applied at the individual object mesh level (not to group nulls). One master material was created for each tissue type and then applied to each object individually. Additional materials were then created for sets of objects or individual objects that needed individual material luminance and/or transparency animation. When these additional materials were applied, the color channel was disabled and mix textures was enabled (\texttt{Attributes > Tag > MixTextures}). (Note: This approach allowed simplified keyframing of material effects for individual objects, as well as sets of multiple objects depending on the situation. For example, master ligament, deep layer, superficial layer, and individual ligament component materials were created. This allowed the entire superficial layer to be ghosted with (one keyframe set) to reveal the deep layer showing a glowing PTTL (one keyframe set) with the master ligament material controlling the color channel of all of them.)
Glowing

The glowing effects were achieved by animating the luminance channels of the non-master materials (Figs 105-107). A layer texture was used in the non-master materials to group the attachment luminance masks into a folder. These luminance masks were PSD texture map exports from ZBrush, which were inverted and flipped vertically (Note: All ZBrush texture maps are exported upside down. In this case they were inverted as well because the texture maps were created from ZBrush masks. A Photoshop action was created to do this with the push of a button (Fig. 105). A solid blue color was created under the luminance masks, which were set to multiply and 0 strength (Fig. 106). To make entire object meshes glow, the mix strength (not brightness) of the luminance channel was increased with all of the luminance masks left at 0 strength. To make a single attachment area glow, the appropriate luminance mask was increased to 100 strength in the keyframes immediately before increasing the luminance channel mix strength (Fig. 107). The luminance mask strength was then decreased to 0 immediately after the mix strength returned to 0 strength. (Note: In essence, the desired attachment luminance mask was turned on right before and after the glow occurred.)

Transparency

The transparency of objects was animated by keyframing the brightness value of the transparency channel on the material unique to that object or sets of objects (Fig. 108). A Fresnel texture with an inverted gradient was used on multiply to produce a ghosting effect.

Bone Articulation Rigging

Joints and rigging were used to create the ankle articulations. Joints (Character > Joint Tool) were created (ctrl+click) and aligned to the centers of articulation for each bone joint. (Note: The 4 view panel makes alignment much easier. Parent joints, or any other parent objects, can be moved without affecting child joints by holding 7 key while moving. Multiple branches can be created by ctrl dragging joints.) IK chains with the 3D solver active in the IK tag were created from each joint chain (select first and last joints, Character > Commands > Create IK chain). Each bone was then given a parent constraint (Tags > Character Tags > Constraint) to act as the child of the corresponding joint in the object manager (Note: Leaving auto reset checked is extremely important so ensure the bone meshes return to their original position for each playback).
Figure 105. Photoshop action created to invert and vertically flip luminance mask texture map.

Figure 106. Luminance mask layering setup.
Figure 107. Keyframing of glow effect.

Figure 108. Keyframing of transparency effect.
IK goals were then made children of control bars created from cubes. The control bars were then animated to control multiple IK goals simultaneously. Joint “webs” were also created by making IK goals of one IK chain the child of a joint of another chain, allowing diverging branches to recombine. This technique was used in the tarsal bones of the foot. Similar joint structures were used to create the animated reactions of the ligaments; however rather than using parent constraints, the ligament meshes were bound to the joints (Character > Commands > Bind). (Note: Binding a mesh to joints allows the mesh to distort when the joints are bent. This is ideal for soft tissues. Making objects children of joints, or constraining them by parent constraints, moves the undeformed object meshes with that joint. This is ideal for hard tissues.)

**Moving Section Effect**

To create the moving section effect through the model, separate subtraction booles were created for bone, ligament, and capsule (with high quality unchecked). For the bone objects, a cube was created and sized to the section to be cut (Figs. 109, 110). The null group of objects to be sectioned was placed as a child of the boole, and the cube was placed underneath it. A material with an animated noise texture was copied from a test project and applied to the cube and adjusted in order to appear to be cancellous bone on the moving sectioned surface (Figs. 111-113). A separate boole was created for the ligament objects in the same fashion; however, to manage the slight overlap between ligaments, a union boole was used to merge the superficial and deep ligament null groups. This union boole was then placed within the ligament subtraction boole with the cube. A third boole was created for the synovial capsule. (Note: Separate booles were created for the bones, ligaments, and capsule because of the overlapping geometry that would be created. Booles have trouble calculating overlapping geometry. This is also why the ligaments were merged with a union boole before being placed in the subtraction boole.) A null object was created to act as a master control for all three booles, which were given a parent constraint targeting the null and slightly offset from each other to prevent overlapping. Auto reset was unchecked in the constraint tags. (Note: It is extremely important that auto reset in unchecked in this case. If not, the cubes will not render in their correct position even if they display correctly in the preview.) Test renders were conducted to verify correct operation (Fig. 114).
Figure 109. View from inside section booles.

Figure 110. Section booles enabled.
Figure 111. Copying animated cancellous bone texture from test project.

Figure 112. Applying animated cancellous bone texture to bone mesh.
Figure 113. Adjusting cancellous bone material.

Figure 114. Test rendering animated section effect.
Ligament Tear Effect

Ligament injury effects were represented by creating a duplicate ligament and forming a complete division across the geometry of the mesh, resulting in two half pieces. These pieces were then positioned together and animated being pulled apart using the mesh brush and point keyframing. This effect was enhanced by creating hair from splines (Simulate > Hair Edit > Convert from Spline) derived from the ligament mesh's vertical edges (Mesh > Commands > Edge to Spline), and animating the length, clump, and frizz channels of a hair material (Materials > Create > Shader > Hair Material) to create a slight fraying appearance.

MR Effects

Creating Animated MR Plane

To create the animated MR slice effect, a MOV file of the desired slices was exported from OsiriX. In the case of this MR data set, the multiplane viewer was used to adjust the slice angle and annotations were turned off (Figs. 115-117). A material was created with the MOV file loaded as the texture and transparency was activated at 50% brightness. Simple mode and exact frame timing was selected in its animation tab and animate preview was selected in the MR material's Editor channel. (Note: These settings are critical to allowing the MR material to animate properly.) Throughout this process the interactive render region was used to view the MR material. A semi-transparent black material was created and added to a cube (renamed MR image cube). The MR image cube was sized to the desired plane dimensions and the MR material was added with tiling disabled, flat projection, and both sides selected in the texture tag. (Note: The order of texture tags is very important. The MR texture tag must be on the right to lie on top of the black texture. It is also critical that the cube remain a primitive to allow resizing without affecting the MR texture.). Xpresso (Tags > Cinema 4DTags > Xpresso) was then used to create the relationship between the z position of the plane and the frame number appearing on the MR material (Fig. 118). Nodes were created by dragging the desired entity into the Xpresso window or right-clicking in the window. An MR image cube Position Z node and Constant node (1) were sent into a Math::Multiply node. The output of this along with another Constant node (0) were sent into a Math:Add node with integer data type. The output of this was sent to two bitmap nodes (drag animation preview to Xpresso), one with a Movie Start Frame in-port, and the other with a Movie End
Figure 115. Slice orientation and contrast set in multi-plane viewer of OsiriX.

Figure 116. Annotations hidden to prevent visibility in movie export.
Figure 117. Slice range and Quicktime movie settings.

Figure 118. Xpresso setup for MR image slices.
Frame in-port. (Note: The basic idea of this setup was to multiply the MR image cube's z position value by a constant yet to be determined, round it to the nearest whole number, offset the number if needed, and set the result as the frame to both play and stop at on the material.) Once the MR image animation was tested to work when moving the MR image cube in the Z direction, the first MR image was scrolled to and a parent null (MR alignment null) was created. A protection tag was placed on the MR image cube, unchecking the z lock to allow movement only in that direction.

**MR Slice Correlation**

The MR image frames were matched to the model by adjusting the scale, frame to distance ratio, and alignment of the MR image cube.

**Scale Adjustment**

To correctly scale the MR image, an identifiable slice was found by moving the MR image cube in the z direction. (Note: Identifiable in this case meant that there were unique structures that could be matched such as the beginning of a bone. The interactive render viewer was used to view the MR image, while the hidden lines display showed the model section.) The corresponding section was found on the model by moving the master section boole null (Fig. 119). The MR alignment null was used to position the slice over the model section. The MR image was then sized to fit using length U and V. Offset U and V were increased to half the percentage decrease in size value. (eg. If 90% Length U, then 5% Offset U).

**Synchronize in Z Direction**

In order to correctly synchronize the MR images to the model section, the ratio of distance to frames had to be found. The frame numbers of the first and last identifiable slice of the MR animation were recorded. The z coordinates of the corresponding slices were found in the model by moving the master section boole null (Fig. 120). The frame difference was then divided by the distance difference to give the ratio of frame range to z distance. This number was then plugged into the first constant null of the Xpresso setup, effectively multiplying the z distance traveled by the MR image cube by this ratio to call up the correct MR frame on the material.
Figure 119. Locating correct model section location for MR image.

Figure 120. Locating first identifiable MR image and correlated model section location.
Align in Z direction

Finally, to align the MR section correctly with the model throughout its z direction movements, the MR alignment null was used to align the first identifiable slice with the corresponding model section (Figs.121,122). The axis of the MR alignment null was moved to be at the center of this section. The MR image cube was then moved posteriorly to the last identifiable MR image and the Xpresso constant node accuracy was checked (Fig.123). The corresponding slice was found on the model section and the MR alignment null was rotated to align the MR image cube with the model (Figs.124-127). (Note: By aligning the first slice and then rotating the setup to align the last slice, the entire MR image sequence aligns with the model.) A protection tag was placed on the MR alignment null to preserve the rotated alignment. Finally, the master section boole null was rotated and aligned to the MR image cube and given a parent constraint targeting the MR image cube (Figs.128-130). The entire setup was then controlled by the z position of the MR image cube, which was animated using keyframes. (Note: It is much faster to work with these booles disabled and their boole cubes hidden when possible. (Fig.131))

Substitution of Final Model into Cinema 4D

To substitute the final model for the initial low-resolution version used in the animatic, the final bone and ligament OBJ models were imported by the same method as the initial OBJ files (see “Importing Meshes” in Part 3: Model and Animation section of Materials and Methods). The meshes were renamed and the texture tags from the initial meshes were copied (cmd+drag) onto their corresponding replacements. The normal and texture maps created in ZBrush were then imported as textures on the Normal and Color channels of the master bone and ligament materials. The groups of final meshes were then dragged into the correct section booles and the initial mesh groups were deleted.

Cortical and Cancellous Bone Effect

To create the effect of a superficial cortical bone layer surrounding cancellous bone, a separate boole setup was created for cancellous bone. To do this, the entire bone boole setup (bone meshes and boole cube) was duplicated. The bone meshes were then each scaled down slightly at their individual centers. The new boole was renamed and the cube was shifted slightly anteriorly. (Note: By creating a separate boole system, intersecting geometry can be easily calculated; however exact
Figure 121. Aligning MR plane with bone mesh using MR alignment null.

Figure 122. Fine tuning alignment of MR plane with bone mesh using MR alignment null.
Figure 123. Checking operation of constant node z-position to frame ratio set Xpresso.

Figure 124. Using MR alignment null to position MR plane by matching MR image to bone mesh.
Figure 125. Using MR alignment null to position MR plane by matching MR image to bone mesh.

Figure 126. Using MR alignment null to position MR plane by matching MR image to bone mesh.
Figure 127. Checking MR alignment from posterior view.

Figure 128. Section booles prior to alignment with MR plane.
Figure 129. Fine tuning section boole alignment with MR plane.

Figure 130. Section booles aligned with MR plane.
Figure 131. Section booles disabled for faster processing.
polygon overlap must still be avoided. The cancellous boole was moved slightly anteriorly to avoid exact overlap.) The cancellous bone noise material from the original bone boole cube was left un-modified in the new cancellous bone boole. A new material was created to resemble cortical bone and applied to the cube within the original bone boole.

**QTVR Exports**

QTVR files of the final model at different timepoints of the animation were exported in the same manner as the digital dissection photogrammetry models, but with the Quicktime VR start angle value set to 90 degrees. (see “Texture Mapping, Lighting, and Exporting from Cinema 4D” in Dissection Photogrammetry Models section of Materials and Methods)

**Final Render**

Prior to final rendering, a low-resolution test render was executed of each sequence to ensure proper animation. Key and fill lights were created and tinted. Short full resolution test renders were then executed to ensure proper lighting of the animated sequences. The final animation sections were rendered as separate PNG sequences at a resolution of 1920X1080.

**Compositing in After Effects**

After Effects was used to:

- Add labels and other text throughout the animation
- Add MR and dissection still images to animation
- Edit clips and narration
- Export final animation in multiple formats

The PNG sequences exported from Cinema 4D and narration audio files were imported into After Effects and arranged in a new composition. The audio files were aligned based on the same start frames used in Cinema 4D. Titles, labels, lists (text tool) and leaders (line tool) were added and animated to fade in and out. MR still images were imported, positioned, and animated following the storyboard. Motion tracking (Window > MotionTracking) was used to allow the labels and leaders to follow the corresponding structure.
3D Printed Model

The final model file was prepared for 3D printing using ZBrush’s 3D Print Exporter and Autodesk’s MeshMixer App. The STL file was then uploaded to the ShapeWays website and a 3D print order process was completed.
RESULTS

Dissection

Dissections were performed to gain a thorough understanding of the deltoid ligament complex structure and the anatomical characteristics of the component ligaments. The photos taken to document the dissection demonstrate the spatial relationships of the overlying structures as well as those between the different component ligaments. Especially noteworthy was the spatial relationship of the deltoid ligament complex to the synovial sheaths and tendons of the tibialis posterior (PTT), flexor digitorum longus (FDL), and flexor hallucis longus (FHL) as well as the flexor retinaculum. The septa that separate the compartments through which the PTT and FDL run strongly connect the flexor retinaculum to the deltoid ligament. When photographing, the septa were first trimmed, but not removed, in order to display their position over the deltoid ligament. On all of the specimens the FHL, in its synovial sheath and ligamentous tunnel, ran very deep under the medial tubercle of the talus and the sustentaculum tali of the calcaneus and was more difficult to mobilize.

When the deltoid ligament was exposed, it was visualized at first as a continuous ligamentous delta-shaped band spanning from the tibia to the tarsals distally. In all of the specimens, the divisions between the component ligaments were not immediately apparent. Only through cleaning and palpation of the boney attachment sites were the components of the deltoid ligament complex distinguished. The fibers of the ligaments were visible enough to be traced from their distal attachments to their proximal attachments on the tibia. When the deltoid ligament complex was sectioned, the thicknesses of the components were clearly seen. The posterior tibiotalar ligament (PTTL) was extremely robust and its attachment site on the talus appeared to be a large soft-cornered diamond shape that lay tightly under the medial articular surface of the talar trochlea. The fibers of the PTTL were interspersed with soft, fatty tissue consistent with its MR imaging characteristics. The anterior tibiotalar ligament was much smaller than the PTTL and was consistently visible just anterior to the PTTL. Both the ATTL and PTTL appeared to be wrapped in a layer of synovial membrane within the capsule. The tibionavicular component (TNL) was difficult to distinguish in the dissections and was usually fused with the anterior portion of the synovial capsule.
The TNL was by far the thinnest observed component of the deltoid ligament. The tibiospring ligament (TSL) was observed to be the thickest component of the superficial layer and was seamlessly interwoven with the spring ligament. The spring ligament itself was observed to have a tough fibrous concave plate fused to its surface. This plate, which assists the low friction gliding of the FDL tendon over the spring ligament, matched the descriptions of several literature references.

The tibiocalcaneal (TCL) component was clearly observed attached to the sustentaculum tali of the calcaneus. At its posterior border, the TCL seemed to extend slightly onto the medial tubercle of the talus, which would account for some studies claiming the existence of a superficial posterior tibiotalar component. When viewing the TCL component from the posterior aspect, the distinction between the superficial and deep layers of the deltoid ligament was very apparent. The capsule borders could be separated and followed deep to the superficial components, demonstrating the two layers of the deltoid ligament.

123D Catch Digital Dissection Models (QTVRs)

The 123D Catch digital dissection photogrammetry models (Figs.132-135) allow an interactive observation of the ankle dissections at different stages. Any individual with access to the QuickTime application can view the model from any desired angle and zoom in to see additional detail. The models demonstrate key stages of the dissection with the deltoid ligament exposed and intact. The tendons that normally overlie the deltoid ligament are shown in place, reflected, or retracted depending on the stage of dissection and to show the spatial relationships of the structures. In one of the models, colored paper clips indicate the different components of the deltoid ligament. The quality of the photogrammetry models created and the QTVR rendering resolutions allow for the viewing of a fairly high amount of tissue detail. These models represent the specimens fairly accurately and provide a decent, though not ideal, substitute for individuals unable to view the specimens in person.
Figure 132. QTVR of preserved dissection.

Figure 133. QTVR of preserved dissection.
Figure 134. QTVR of preserved dissection.

Figure 135. QTVR of preserved dissection.
**Digital Model**

The digital model created in ZBrush clearly shows the overall structure, layers, and ligamentous components of the deltoid ligament (Figs. 136-139). The ligament is shown without surrounding structures in order to represent it most clearly. The forms of the bone components are extremely accurate to the cadaver specimen due to the fact that they are based on the CT scan data. The attachment sites shown in the model represent knowledge gained from dissection observations, MR image interpretation, and reference literature. Due to time constraints the still images of the final rendered model was not yet available.

**Animation**

The animation created serves as a tool to assist orthopedic radiology trainees in understanding the deltoid ligament complex (Figs. 140-155). The animation consists of three sections, which demonstrate the component anatomy, MR imaging characteristics, and injuries of the deltoid ligament. A narration guides the viewer through the animation and supplements the visual communications. In section 1, highlighting, transparency effects, and labeling demonstrate the different components as well as their attachments. In section 2 of the animation, moving cross sections, highlighting, and labeling orient the viewer and instill a deeper understanding of the correlation between the 3D anatomy of the deltoid ligament and the 2D MR imaging. In section 3 of the animation, highlighting and labeling communicate the classifications of deltoid ligament injury. Due to time constraints the still images of the final rendered animation was not yet available.

**3D Print of Ligaments**

The 3D print of the deltoid ligament and surrounding region was created to further reinforce the spatial understanding of the deltoid ligament complex. The printed model shows the relationship between the different components of the deltoid ligament, as well as the attachment sites on the tibia and tarsal bones. Due to the turnaround time of the 3D printing company contracted to create the model, photos of the model are not included in this written work.
Figure 136. Low resolution render of deltoid ligament model.

Figure 137. Low resolution render of deltoid ligament model.
Figure 138. Low resolution render of deltoid ligament model.

Figure 139. Low resolution render of deltoid ligament model.
Figure 140. Animatic still highlighting tibia.

Figure 141. Animatic still highlighting deep layer of deltoid ligament.
Figure 142. Animatic still highlighting talocrural joint.

Figure 143. Animatic still highlighting navicular bone.
Figure 144. Animatic still of complete deltoid ligament.

Figure 145. Animatic still of ghosted superficial layer.
Figure 146. Animatic still highlighting TNL.

Figure 147. Animatic still demonstrating TNL relationship to other components of deltoid ligament.
Figure 148. Animatic still highlighting ATTL.

Figure 149. Animatic still highlighting PTTL.
Figure 150. Animatic still highlighting anterior and posterior colliculi as well as intercollicular groove.

Figure 151. Animatic still highlighting attachment sites of PTTL.
Figure 152. Animatic still demonstrating animated MR section effect.

Figure 153. Animatic still demonstrating animated MR section effect.
Figure 154. Animatic still demonstrating MR to model correlation.

Figure 155. Animatic still demonstrating MR to model correlation.
Access to Assets Resulting from This Thesis

Access to the files and animation resulting from this thesis can be viewed at SilverMedicalVisuals.com or by contacting the author at michaelsilver003@gmail.com.

The author may also be reached through the Department of Art as Applied to Medicine via the website www.hopkinsmedicine.org/medart.
DISCUSSION

EXPLORATORY APPROACH

One of the goals from the outset of this project was to find new and innovative ways to utilize and combine the capabilities of the software programs utilized in this study. In the planning stage of the project, a significant amount of time was spent exploring the capabilities of 123D Catch, ZBrush, Cinema4D, and AfterEffects before they were used to create the final models and animations. By taking this approach, new workflows were discovered that gave rise to more inventive and efficient techniques. Over 100 short tutorials were watched, some of the most helpful of these being the QuickTips on the Maxon YouTube channel. These short 1-3 minute tutorials each demonstrate in a simple, clear, and concise manner a particular tool or function within Cinema4D. Many of these short QuickTips served as the inspiration for a new solution to a challenge or a completely new idea to include in the project. Because there are often many ways to solve challenges in the 3D digital environment, previewing the collection of available tools allows for more creative problem solving and exponentially faster and cleaner solutions. More efficient alternatives to repetitive and time-consuming processes were constantly sought out or invented whenever possible. In many cases, more efficient methods of completing tasks were discovered through a quick web search resulting in a solution found in a video or forum. By way of this process, several novel techniques for modeling and animation were discovered and implemented. Although this investigative approach affected the original timeline and procedure set for the project, it allowed for a much more fulfilling and enjoyable educational experience as well as more sophisticated end products. One result of this type of flexible exploratory philosophy was the inclusion of the photogrammetry aspect of the project. Initially, photogrammetry models were not included as part of the thesis proposal; however when the potential for its use was discovered through experimental tests, it was incorporated as a major element of the project. All this being said, this exploration had to be somewhat curbed given the limited time to complete this project.
INNOVATIONS AND APPLICATIONS

Many innovative approaches and techniques were developed or improved upon throughout the course of this project. It is the author's hope that these new workflows will be further explored and improved upon by future medical artists.

PHOTOGRAMMETRY MODELS

The dissection photogrammetry models created using 123D Catch were inspired by the experimental work of Brandon Pletsch and Adam Pellerite of Thomas Direct Studios which they presented at the 2013 AMI Meeting in Salt Lake City. In this thesis, the photogrammetry setup and shooting techniques were significantly improved beyond the guidelines recommended by the 123D Catch website. Specifically, the shot numbers, rings, and angles, the use of a moving background, and the lighting techniques were significant improvements over the official Autodesk recommendations. In addition, the batch processing of photos in Camera Raw to ensure optimal detail was novel in this context. Finally, the specific processing of the models in ZBrush and Cinema4D as well as the creation of QTVR files was unique to this project. Independent of the workflow used, the creation of digital dissection photogrammetry models allows dissections done anywhere in the world to be utilized indefinitely by colleagues and students with access to the online or local files. In a sense, the dissection is frozen in time, allowing its unlimited use as a resource. As previously demonstrated by Pletsch and Pellerite, this technique can also record a dissection process by capturing the specimen at different stages, providing spatial relationship or procedural information.

ZBrush

“Digital Putty” CT Surface Model Repair Using Project All

Perhaps the most widely applicable of these novel techniques is the repair workflow used to create clean watertight meshes from suboptimal CT scan data. Very often CT scan data must be exported as partially degraded OBJ files with a large amount of unwanted inner branching geometry. Rather than attempting to painstakingly sculpt another mesh to match the form before remeshing, a much more efficient technique was developed as a part of this thesis. In essence, a “digital putty” was created to fill in the damaged or missing areas of the scan data and adopt the general form of each bone. Using the Project All function in ZBrush allowed the “digital putty” to
be formed progressively closer to the undamaged surface of the CT data with each subdivision and application, while ignoring the damaged or missing areas. The Project All function also allowed small detached pieces of desired bone surface data to be used as guides to interpolate the full shape of the bone in those areas. This technique has applications for any situation in which incomplete or damaged data set-based meshes need to be repaired to their complete form.

**ZProject Brush Ligament Attachments**

Also useful to medical illustrators working in ZBrush is the technique of using the ZProject brush to create accurate ligament attachment contours. Similar to the Project All function, the ZProject brush allows one mesh’s surface to conform to another mesh surface with high accuracy; however, unlike the Project All function, the ZProject brush allows extremely precise control over the process. This is ideal for situations in which only certain portions of a mesh need to conform to another mesh surface. By controlling the brush size, strength, and focal strength, as well as alternating use of the Smooth brush, very specific and otherwise difficult results can be achieved. Another novel aspect to the application of the ZProject brush in this case was its use from the inside of the bone meshes. By hiding the majority of the bone meshes, the ZProject brush was used to pull and push the ligament to its exact attachment surface contour from inside the bone. This technique would also be very useful for modeling muscle and tendon attachments, as well as any other tissue meshes that need to be conformed exactly to the contour of another mesh in tight areas. One interesting future experiment would be to use alpha textures with the ZProject brush which would cause small patches of polygons to conform to the other mesh based on the alpha texture information. This might be useful for septa or projections between tissues or membranes of irregular shape respectively.

**CT, MR, Laser Scan, and Photo Modeling Integration**

Another innovation related to the creation of the digital model was the combined use of CT, MR, 3D laser scan, and photos to create a highly accurate representation of the bones and ligaments. Though these data sets are often used for digital model creation, rarely are they all combined to create one model. In order to ensure that the MR images and CT-based bone models would integrate seamlessly in the modeling and animation processes, CT and MR data from the same non-preserved cadaver specimen was used. To further improve the detail and realism of the
model, 3D surface laser scan data and photos were obtained from a dry bone specimen. Ideally, all four types of data would have come from the same specimen, however due to time and logistical constraints two different specimens were used. This method of combining different types of data-sets can be used in the future to create highly accurate and detailed digital anatomical models.

**Cinema4D**

**Moving Cross Section Synced with MR Scrolling**

Newly developed in this thesis was a dynamic integration of MR imaging with a 3D moving cross section of the digital anatomical model. Because the bone surface rendering created for the CT scan and the MR images were acquired from the same specimen, nearly seamless integration between the two was possible. A workflow was developed using the Xpresso node programming feature in Cinema4D, which allows the user to control nearly any parameter of any entity by any parameter of any other entity. This powerful feature was utilized in this project by controlling the MR slice number by the position of the plane created within the animation. The potential of this setup is extremely useful for medical illustrators working in the 3D environment. Not only does it allow for visually dynamic and didactic cross section animation sequences, but it also allows for the use of MR and other data sets as templates for digital modeling. Bone surface renders can be created from CT data sets fairly easily, yet soft tissue poses a challenge in this respect. Similar to traditional methods that use cross section slices as guides for physical 3D model creation, this technique allows for aligned digital modeling templates of all imaged tissue types that are as accurate as the data set’s resolution and slice thickness. The multiple boole aspect of the moving cross section technique can also be used in situations where structures are layered or surrounded by another tissue. The classic anatomical images of the layers of the skin, brain meninges, or vessel wall could be revealed in a dynamic, sequential staggered fashion. The nerves or vessels of a muscle group could be revealed by expanding the invisible section of muscle tissue.
**Bone Articulations**

Bone articulations were another area in which this project utilized the powerful features of Cinema4D. By rigging the model with joints in inverse kinematic (IK) hierarchies, the model was easily manipulated with a few IK goals. To make the movements more realistic, these goals were set as children to a control bar, much like the string attachments of a marionette. This allowed the manipulation of multiple goals and their corresponding IK chains via the position and rotation of one control bar, producing more natural and harmonious movements between multiple IK hierarchy chains.

**Material Hierarchy and Luminance Masks**

Material property animation was also utilized in a novel way in this project. A virtual material hierarchy was created through the distribution of texture tags to allow control of certain material properties at different levels. This approach simplified animation by allowing the keyframing of a single material to affect multiple object appearances, while preserving the ability to keyframe each object’s material properties individually. An example of this was the partial transparency of the entire superficial layer of the deltoid ligament, while individual component ligament luminance values were changing simultaneously. The alternative would have been to synchronize each component’s transparency individually throughout the entire animation, taking much longer and posing a potential nightmare if major timing adjustments were needed. Additionally, the material layer functionality, specifically the luminance channel, was used extensively to create the glowing ligament attachment effects. Greyscale texture maps exported from ZBrush were used as luminance masks, allowing only certain areas on the surface of the model to glow at certain times.

**Obstacles and Solutions**

Many obstacles were encountered throughout the course of this project. In each case, the setback was reframed as a challenge and, in many cases, resulted in a new workflow that benefitted this project and will continue to of great value to the author and other students who undertake similar projects in the future.
Scanning

One challenge encountered throughout the process of this project was the availability of MR and CT scan time. Because the MR and CT scanner units used for this project were under strict scheduling limitations, it was difficult to coordinate blocks of scan time on short notice. Adding to the challenge was the fact that the specimens being scanned were non-preserved and therefore susceptible to degradation and putrefaction. The CT unit that was used also had a limited field size which required two separate scans for each specimen, resulting in the need to combine two surface models later in the workflow. Technical scanning problems also occurred, yielding a sub-optimal data set. Additionally, because of the need for safe handling, the specimens were not removed from their multi-layer biohazard bags. This prevented ideal positioning of the specimen during CT and MR scans resulting in slight positional differences at the talocrural joint. These positional differences had to be accounted for during the digital modeling and animation process. Earlier planning and scheduling would have provided time to resolve many of these problems and may have eliminated some completely.

Osirix

Technical issues were also encountered when creating surface renders in Osirix due to the processing demands of the program. Initially the free 32-bit version of Osirix was used; however it became apparent that the 64-bit version was required to get the needed level of detail in the surface render. Even using the 64 bit version, the data set was so immense that the surface render resolution slider could not be moved beyond approximately halfway without crashing the program. Osirix crashed repeatedly. To manage this, OBJs were exported at increasing resolutions, until the program crashed. Another issue encountered in Osirix was due to the suboptimal CT scan quality. The surface models that were procured had a good deal of noise and missing data, which manifested in complex inner branched geometry. Additionally, Osirix merged most of the bones into a single convoluted mesh. The solutions to these challenges resulted in the development of the ZBrush CT surface model repair workflow.
**ZBrush**

By many people's standards, ZBrush has a poorly designed interface that is not intuitive to use; however, the capabilities of the program in terms of manipulating meshes and texture maps are extremely impressive. Despite the frustrations and workarounds due to interface design, ZBrush proved to be an invaluable tool for repairing, modeling, and texturing.
CONCLUSION

This project utilized several different resources, combining the strengths of each to create visualizations of the deltoid ligament that are novel and more accurate than many references currently available. The dissection photogrammetry models, digital deltoid ligament model, animation, and 3D printed model may be used in combination to synergistically demonstrate the structure and MR appearance of the deltoid ligament. An exploratory approach was taken to discover new techniques for medical illustrators working in the 3D environment and test the limits of the software applications. It is the hope of the author that this project will assist orthopedic radiology residents in gaining a comprehensive understanding of the complexities of the deltoid ligament and its appearance in the context of MR image interpretation.

This project sets the stage for multiple future areas of study. Models and animations for the remaining ankle ligaments or those of other joints could be created using a similar workflow. Other structures of the ankle and foot could be added to the digital model created in this thesis, which could then be repurposed for use in 3D interactive design software such as Unity. This would allow for testing of anatomical and medical knowledge gained from animations or other sources. Additionally, the integration of ontology into the interactive experience would add an entirely new level of effectiveness to the educational program. Ontology would allow instant access to related literature, images, video, and other information directly from the interface. The combination of digital models, guided animations and interactive learning has the potential to be a very powerful resource in the training curriculum of orthopedic radiology.
CITED REFERENCES


GENERAL REFERENCES


VITA

Michael Silver was born in Los Angeles, CA and grew up with passions for movie special effects, sculpting, music, ice hockey, inventions and animals. He received his bachelor’s degree in biology from Tufts University while simultaneously attending the School of the Museum of Fine Art in Boston, where he studied traditional figurative art with an emphasis on sculpture. After working in biotechnology, Michael transitioned into the field of product design and prototype fabrication where he gained proficiencies in digital 3D modeling as well as machining, casting, and 3D printing processes. During his 6 years in product design at Royer Labs, a professional microphone manufacturer, he continued to develop his traditional artistic abilities and furthered his biological studies in preparation for his career in medical illustration. Michael is currently in his second year in the Medical and Biological Illustration Masters Degree program at the Department of Art as Applied to Medicine at Johns Hopkins University School of Medicine and is a candidate to receive a Master of Arts in 2014. After graduation, he is looking forward to innovating, collaborating with colleagues, and contributing to the field of medical illustration.